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C H A P T E R  1

INTRODUCTION

The Blackbaud FundWare™ Payroll/Personnel module gives you the ability to manage 
and report on your organization’s payroll easily and effectively. With Payroll/Personnel, 
you can:

• Maintain employee master records and history.
• Distribute expenses to multiple departments and/or General Ledger accounts.
• Define custom data items, including taxes, deductions, and employer costs.
• Allow multiple payroll accrual accounts and cash accounts.
• Create timesheets for a group of employees in a single step.
• Enter one or more timesheets for your employees in a single form.
• Process checks (e.g., produce checks, void checks, enter manual checks).
• Create direct deposit files.
• Post financial data to General Ledger, Project/Grant, and Accounts Payable.
• Process your W-2s (e.g., extract information, print W-2s, create electronic file).
• Update your earnings, taxes, deductions, and employer costs using the ToolBox.

THE PAYROLL PROCESS
The following steps represent a typical pay period. Procedures vary for each 
organization; you may not perform all of these steps or you may perform more.

1.  Create employee timesheets.

2. Verify (and correct if necessary) timesheets.

3. Post timesheets.
Blackbaud, Inc. 2.1
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4. Enter one-time deductions.

5. Calculate net pay.

6. Produce and review a Preliminary Check Register.

7. Produce checks and direct deposit payments.

8. Log printed check numbers and direct deposit payments.

9. Reconcile checks and direct deposit payments.

DEPARTMENTALIZATION, COSTCODES, AND DISTRIBUTION TABLES
The most-critical Payroll decision will determine how the system uses your settings and 
entries to resolve (or “build”) the account number to which you post your Payroll costs:

• Are you departmentalized, or 
• Are you not departmentalized?

This setting is defined on your Payroll Parameter and can be different for salaried, 
hourly, or “other” employees (Figure 1.1). (See Defining the Payroll Parameter on page 
1.34 for more information on the parameter.) 

Figure 1.1—Departmentalized Salary and Non-Departmentalized Hourly

Once this has been determined, you can decide if you are using costcodes or distribution 
tables:
Departmentalization, Costcodes, and Distribution Tables 
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• Costcodes can be used with departmentalized or non-departmentalized 
earnings.

• Distribution tables can only be used with non-departmentalized earnings.
The following sections explain these options and general instructions for implementing 
them. Specific instructions for each topic can be found later in this guide: 

• Creating Departmentalized Earnings on page 1.72,
• Implementing Costcodes on page 1.46, or
• Creating Distribution Tables on page 1.67.

For examples of how Payroll uses these settings to resolve the account number during 
timesheet entry, see Appendix C—How Does Payroll Resolve Accounts? on page 1.259.

DEPARTMENTALIZED EARNINGS

The departmentalized earnings option represents a very specialized method of 
accounting. You should use the departmentalized earnings option if all or most of your 
employees have different wage distributions. When you define Salary, Hourly, and/or 
Other as departmentalized, you must also define departments and GLAs for each 
departmentalized option. You can then select and store these settings on the employee 
record.

GLAs are literally “General Ledger accounts.” In everyday usage, they often 
represent the “natural” account or object code of an account number and define 
what the employee does or the cost category to which they belong. However, 
when we refer to GLAs in the program, we are referring to an additional piece 
of your Payroll setup (.H GLA, .S GLA, or .O GLA) and a setting on the 
employee record. You can use the department and GLA to refine how Payroll 
builds your account numbers.

HOW DO YOU IMPLEMENT DEPARTMENTALIZATION?

There are three primary steps that you must complete to prepare your system for 
departmentalization. 
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1.  Define the Salary, Hourly, and/or Other earning type as 2 (Departmentalize) in 
field 1 of the Payroll Parameter (Figure 1.2). 

Figure 1.2—Departmentalized Setting in Division 95 Payroll Parameter

For more information on the payroll parameter, see Defining the Payroll 
Parameter on page 1.34. 

2. You define edit values for each of these employee data items to represent all the 
departments (.S DEPT, .H DEPT, and/or .O DEPT) and GLAs (.S GLA, .H 
GLA, and/or .O GLA) that are needed by your organization.
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3. You define one or more departments and GLAs for each employee on the 
Accounting Information tab of the employee record (Figure 1.3). (This is 
optional. Depending on other settings, the system will still be able to resolve the 
account number if the employee does not have a department and GLA setting.) 

Figure 1.3—Example .S DEPT and .S GLA Entry on Accounting Information Tab

Because you have defined the Salary, Hourly, and/or Other earning type 
as departmentalized, Payroll allows you to enter multiple definitions for 
your salary, hourly, or other settings. Non-departmentalized Salary, 
Hourly, and/or Other earning types allow only one entry (i.e., 100% to a 
single department, GLA, and Additional basis for).

For examples of how Payroll resolves the account number in a departmentalized system, 
see Appendix C—How Does Payroll Resolve Accounts? on page 1.259.

ARE DISTRIBUTION TABLES EASIER?

If you do not use distribution tables for a departmentalized configuration, each change 
to your system may force you to make changes to every employee record. However, you 
may find that defining and maintaining 20–30 distribution tables may be easier than 
adjusting the departmentalized earnings for each employee each time the information 
changes. 

These options are defined as edit values 
to the .S DEPT employee data item.

These options are defined as edit values to 
the .S DEPT employee data item.

.S PCNT

.S GRP
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COSTCODES

You can use costcodes when your organization wants to code wage expenses to a 
specific project or “job” through an account number. In costcode accounting, employees 
usually work in multiple departments but there is no consistent distribution of labor. 
Employees may also have rates of pay that vary by department. 
Defining your system to use costcodes involves settings on a number of different 
records:

• Payroll parameter,
• Earnings items (i.e., historical data items with the History type defined as 

E—Earnings), 
• Edit values for employee data items (.COSTCODE and/or .COSTRATE, 

depending on your setup), 
• Employee records, 
• Timesheets.

See the following sections for example uses of costcodes. See Implementing Costcodes 
on page 1.46 for specific instructions to implement costcodes.

EXAMPLE COSTCODE—RATE DEFINED ON EMPLOYEE RECORD

Charles Applecart works for Emerald City’s vehicle maintenance department earning 
$12 per hour. The vehicle maintenance department charges each city department for 
work on city vehicles. For example, Charles may work on police cars year-round (for 
the police department), but work on graders in the summer (for the road maintenance 
department) and snow plows in the winter (for the snow removal department). 
Therefore, we define an edit value for .COSTCODE for each city department to ensure 
that the hours are billed correctly. When we enter a timesheet for Charles Applecart, we 
select the correct edit value for the hours worked. Payroll defaults the rate to the Hourly 
rate defined on the Payroll Information tab of the employee record (which corresponds 
to employee data item .H AMT) and resolves the account number to charge the correct 
city department for these hours.
See Implementing Costcodes—Rate Defined on Employee Record on page 1.46 for 
specific instructions to implement this type of costcode setup. For examples of how 
Payroll resolves the account number using costcodes, see Appendix C—How Does 
Payroll Resolve Accounts? on page 1.259.
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EXAMPLE COSTCODE—RATE DEFINED ON .COSTCODE

Prucilla Pear works for Emerald City’s safety department as an emergency medical 
technician (EMT). However, she occasionally works as a standby firefighter for the city. 
EMTs earn $25 per hour, while firefighters earn $30 per hour. Because Prucilla is paid at 
different rates, we define .COSTCODE edit values for each department, including a 
lookup column 3 to hold the rate. We enter two pieces of information on Prucilla’s 
record:

• Hourly rate on the Payroll Information tab—Payroll will multiply the hourly 
amount by the rate defined by the hours billed. Therefore, to accurately reflect 
our EMT and firefighter rates, we enter 1.00 in the Hourly rate field. 

Certain organizations use this feature to better reflect a more 
complicated payroll calculation.

• .COSTCODE added to the Pay Calculation tab—Because most of Prucilla’s 
time is billed at the EMT rate, we select this edit value. When we enter a 
timesheet for Prucilla, the default .COSTCODE edit value will be EMT. We can 
change this for those hours that should be billed at the firefighter rate.

See Implementing Costcodes—Rate Defined on Employee Record on page 1.46 for 
specific instructions to implement this type of costcode setup. For examples of how 
Payroll resolves the account number using costcodes, see Appendix C—How Does 
Payroll Resolve Accounts? on page 1.259.

EXAMPLE COSTCODE—MULTIPLE RATES DEFINED ON EMPLOYEE RECORD

The Greene County parks and recreation department has three employees: Georgetta 
Berry, Oda Mae Pineapple, and Don Strawberry. Each of the employees may work at a 
variety of tasks:

• Georgetta usually works with wildlife management, where she earns $18 per 
hour. Sometimes she fills in on the night patrol of the park, where she earns $16 
per hour.

• Oda Mae is a researcher and earns $25 per hour. She also spends part of her 
week working with wildlife management, where she earns $20 per hour.

• Don usually works the night patrol, where he earns $17 per hour. However, he’s 
working on an advanced degree in biology and assists in the research 
department on occasion, where he earns $19 per hour.

Because each employee works at a variety of tasks and earns different amounts for each 
task, we decide to use the Costcode with rate override option. This option allows us to 
add an edit value and define a unique rate for each task on the employee’s record.
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We define .COSTCODE edit values for each department, then enter three pieces of 
information on each record:

• Hourly rate on the Payroll Information tab—Payroll will multiply the hourly 
amount by the rate defined by the hours billed. Therefore, to accurately reflect 
our payroll rates, we enter 1.00 in the Hourly rate field. 

Certain organizations use this feature to better reflect a more 
complicated payroll calculation.

• .COSTCODE added to the Pay Calculation tab—Because most of Prucilla’s 
time is billed at the EMT rate, we select this edit value. When we enter a 
timesheet for Prucilla, the default .COSTCODE edit value will be EMT. We can 
change this for those hours that should be billed at the firefighter rate.

• .COSTRATE added to the Pay Calculation tab—For each .COSTCODE that 
we add, we add a corresponding .COSTRATE data item and enter a rate.

See Implementing Multi-Occurring Costcodes (Complex) on page 1.60 for specific 
instructions to implement this type of costcode setup. For examples of how Payroll 
resolves the account number using costcodes, see Appendix C—How Does Payroll 
Resolve Accounts? on page 1.259.

DISTRIBUTION TABLES

You can use distribution tables in situations where wage expenses are consistently 
distributed to the same accounts using the same percentages. You define the accounts 
and percentages to which you are posting and assign that distribution table to employee 
records or to individual timesheet entries for your employees.
This option works well for:

• Salaried employees whose wage expense accounts are the same every period, or 
• Hourly employees whose wage expense accounts are the same regardless of the 

number of hours worked. 

HOW DO YOU IMPLEMENT DISTRIBUTION TABLES?

There are two primary steps that you must complete to prepare your system for 
distribution tables.
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1.  The first step to using distribution tables is to enter Y (Distribution tables are 
used) in the Dist tables field of the Payroll Parameter (Figure 1.4). See Defining 
the Payroll Parameter on page 1.34 for more information on the parameter. 

Figure 1.4—Distribution Table Setting in Division 95 Payroll Parameter

2. After you define the Payroll Parameter to allow distribution tables, you must 
define the tables themselves (Figure 1.5) and modify the .DIST TBL employee 
data item definition. (For specific instructions, see Creating Distribution Tables 
on page 1.67.) 

Figure 1.5—Distribution Table Definition

Once you have completed these setup tasks, there are two ways to implement 
distribution tables.

In Sample Division 
95, the Dist tables 
field is set to Y 
(Distribution tables 
are used).
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• You can attach a distribution table to the Pay Calculation tab of the employee 
record of all relevant employees (Figure 1.6). 

Figure 1.6—Attaching a Distribution Table to the Employee Record

Each time you create a timesheet for the employee, Payroll will provide that 
table as a default distribution table if the earnings item is defined for distribution 
tables (Figure 1.7). 

Figure 1.7—Example Timesheet—Default Distribution Table
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Or you can attach a distribution table directly to the timesheet, bypassing the 
employee record (Figure 1.8). 

Figure 1.8—Example Timesheet—Adding a Distribution Table

For examples of how Payroll resolves the account number using distribution tables, see 
Appendix C—How Does Payroll Resolve Accounts? on page 1.259.

THE PAYROLL/PERSONNEL HOMEPAGE
The Payroll/Personnel HomePage helps you keep an eye on upcoming activities and 
provides you with direct access to produce your reports. The following areas make up 
the Payroll HomePage:

• Activity Reminder area, and
• Reports area.

ACTIVITY REMINDERS

The Activity Reminders area allows you to enter a text note and a due date (optional) for 
module tasks (Figure 1.9). When you open the HomePage, any tasks with due dates 
earlier than the system date of your computer (i.e., “overdue”) will display as red. 

Figure 1.9—Activity Reminders Area
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Use the following instructions to use the Activity Reminders area.
1.  On the General Ledger HomePage, enter up to 100 alphanumeric characters in 

the Activity field (Figure 1.10). 

Figure 1.10—Example Activity Reminder—Prenotification Reminder

2. If this task has a due date, enter the date in the Due Date field. Click the drop-
down arrow to access the calendar. This field is optional.

If you do not have any text associated with a due date, the due date will 
not be saved when you exit the HomePage.

Your entries are saved when you close the HomePage or FundWare. You can edit the 
text or date information at any time.

PRINTING REMINDERS

Click Print to print the information in the Activity Reminders area. The report output 
will reflect the current sorting and displays in a preview window, from which you can 
print the information.

DELETING REMINDERS

Use the following instructions to delete a reminder.
1.  Highlight the row.

2. Click Delete. A confirmation message displays.

3. Click Yes.
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REPORTS AREA

The same categories that you see in Report Manager for the module will also display in 
the Reports Area of the HomePage (Figure 1.11). Each category can expand and 
collapse to show or hide the reports contained within. A single click of a report title will 
display the report parameters screen. Once you enter the details of the report and click 
OK, your report is produced. 

Figure 1.11—Reports Area of the Payroll/Personnel HomePage

USING THE FOLDERS
Folders represent tasks or steps in Payroll/Personnel work flow. The folder tree displays 
on the left in the main Payroll/Personnel window. When you select a folder, the 
information in the selected folder is listed in the detail pane on the right (Figure 1.12). 

Figure 1.12—Payroll Main Window

The buttons at the bottom of the screen will change to match the actions allowed for that 
folder. A disabled (i.e., grayed-out) button can mean that you must first select an item or 
that your security level does not give you access to this function. 
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USING MASKS
A “mask” is an FundWare term for using a “wild card” in an account number to indicate 
a group of accounts. The best use of this feature is for processing and reporting. Where 
an X is placed in a mask, any value in that digit position will be accepted. 

In Sample Division 96, if you enter the mask A01 00-00 111X in the Account 
Selector, you will get five accounts:

• A01 00-00 1110, 
• A01 00-00 1111, 
• A01 00-00 1112,
• A01 00-00 1114, and
• A01 00-00 1115.

SOME FUNDWARE BASICS
The following sections provide you information and instructions for opening and 
working in FundWare.

OPENING FUNDWARE

As you begin using FundWare, certain information is saved by the program and offered 
as a default. This has been designed to help you save time and steps, but you can change 
these defaults at any time by entering new information or selecting from the available 
options (depending on the field).

• User name—The program will enter the user name (or user number) of the last 
person to log into FundWare on that computer.
— For security reasons, your password is not automatically entered. You must 

always enter your FundWare password.
• Business date—Defaults to the current system date (according to your 

computer’s operating system).
• Division—The program automatically selects the division you were working in 

the last time you were in FundWare. 
— If you have only one division (or have security rights to only one division) 

and do not have security rights to the System Administration area, the 
program will bypass the division selection window. 
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— Or, if you only have security rights to the System Administration area, the 
program will bypass the division selection window and open directly to the 
System Administration HomePage.

• HomePage—The program automatically opens to the HomePage of the module 
in which you were working the last time you were in FundWare. 

Use the following instructions to open and log into FundWare.
1.  Double-click the FundWare icon on your desktop or select Blackbaud 

FundWare® Enterprise or Professional from your Windows Start menu. The 
Login window displays. 

Figure 1.13—FundWare Login Window

2. Enter your user name in the User Name text box. You can enter your user 
number instead of your user name, if preferred. 

The User Name field will default to the last entry on this computer and 
the system will move to the Password field.

3. Enter your password in the Password text box. Your password entries will 
display as asterisks (*) as you type to maintain the privacy of your password. 
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4. Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you 
can click the down-arrow to select a date from the calendar.

Figure 1.14—Selecting the Date

5. Click OK. If your User Name, Password, and Business Date are verified, the 
Select Division window displays, defaulting to the division you were working 
with the last time you were in FundWare. 

Figure 1.15—Selecting the Division

If your organization uses the password aging feature, you may receive a 
message indicating that your password will or has expired. You will be 
offered the chance to enter a new password at this time. See Changing 
Your Password During Login on page 2.17.

If you have only one division (or have security rights to only one 
division) and do not have security rights to System Administration, the 
program will bypass the Select Division window. Or, if you only have 
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security rights to System Administration, the program will bypass the 
division selection window and open directly to the System 
Administration HomePage.

6. If necessary, select a different division (or System Administration) from the list. 

7. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

For users upgrading from earlier versions of FundWare, please note that you can only 
have one division open at a time in each instance of FundWare (a change in 
functionality). However, you can open the program multiple times for the same or 
different divisions and/or business dates.

CHANGING YOUR PASSWORD DURING LOGIN

If your organization uses the password aging feature (defined through System 
Administration), you may receive a message indicating that your password will or has 
expired. 

Figure 1.16—Password Expiring

Use the following instructions to change the password at this time.
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1.  Click Yes to the password expiration message. The Change Password window 
displays. 

Figure 1.17—Changing Your Password During Login 

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

You can also change your password from within the software. See Changing Your 
Password From the Software on page 2.21.

OPENING FUNDWARE MULTIPLE TIMES

Each “instance” of FundWare (i.e., each time you open the program) represents a single 
division on a single business date. However, you can open as many instances of 
FundWare as necessary to meet your needs. 
When dealing with multiple instances of FundWare, keep the following rules in mind:

• Each instance of FundWare represents a single user, division, and business date, 
or represents access to the System Administration features by a single user. 

• You can open as many instances of FundWare as necessary (i.e., for different 
users, business dates, or divisions).
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• You can still change the business date for the current instance of FundWare 
without opening a new instance. See Changing the Business Date on page 2.20 
for more information.

OPENING ADDITIONAL INSTANCES—FROM THE DESKTOP/START MENU

If you have one or more instances of FundWare open already, you can open additional 
instances of the program from your desktop or the Windows Start menu. You will be 
asked to identify the user, password, business date, and division (the same steps as 
opening the first instance of FundWare).

OPENING ADDITIONAL INSTANCES—FROM THE PROGRAM

You can also open a new division or a new instance of the same division from within 
FundWare. Because you are opening this division from the program, the system applies 
the same user and password to the new instance and allows you to select a new division 
or business date.

If you want to open a new instance of FundWare for a new division or a new 
business date, you can open the program from the desktop or Windows Start 
menu or from the Change Business Date task. For instructions on changing the 
business date, or opening a second instance of the program with a different 
business date, see Changing the Business Date on page 2.20.

Use the following instructions to open a new instance of FundWare for the current user 
and business date.

1.  Select File > Open FundWare from the menu bar. The Open New Instance 
window displays, automatically selecting the division you were working with 
the last time you were in FundWare. 

Figure 1.18—Opening a New Instance of FundWare

2. If necessary, select a different division (or System Administration) from the list. 
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3. Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you 
can click the down-arrow to select a date from the calendar.

4. Click OK. FundWare opens to the HomePage of the module that you last 
accessed.

CHANGING THE BUSINESS DATE

You can change the business date for your current instance of FundWare or open a new 
instance of the same division with a different business date using the Change Business 
Date task. When you choose to open a new instance of the same division, the system 
applies the same user and password to the new instance and takes you directly to the 
HomePage for the module in which you were last working in that division.

1.  Select Edit > Change Business Date from the menu bar. The Change Business 
Date window displays. 

Figure 1.19—Changing the Business Date 

1 Accept the default business date or enter a new date. You can manually enter the 
date (moving from day to month to year using the arrow key or mouse) or you can 
click the down-arrow to select a date from the calendar.

2 Select the applicable option for applying the new business date:
• Current Instance of FundWare—Changes the business date for the current 

instance of FundWare. This option does not apply any changes to other 
instances of FundWare and does not open a new instance of the program.

The “Classic” windows will not accept a changed business date. If you 
have any of the Classic screens open when you attempt to change the 
business date for the current instance of FundWare, the system will 
return a message and not allow you to proceed. Close the Classic 
windows and try again.
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• New Instance of FundWare—Opens a new instance of FundWare to the 
HomePage for the module in which you were last working, applying the 
same user, password, and division but using the new business date.

1.  Click OK. The program applies your selection.

CHANGING YOUR PASSWORD FROM THE SOFTWARE

Use the following instructions to change the password for the current user.
1.  Select Edit > Password from the menu bar. The Change Password window 

displays. 

Figure 1.20—Changing the Current User’s Password

2. Enter your password in the Old Password text box.

3. Enter the new password in the New Password text box.

4. Retype your password in the Confirm New Password text box.

5. Click OK. Your password is changed. The next time you log into FundWare, 
you must use the new password or you will receive an error message.

If your organization uses the password aging feature (defined through System 
Administration) and your password is nearing or has passed the expiration date, you can 
also change your password during the login process. See Changing Your Password 
During Login on page 2.17.
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USING THE MENU BAR

Each module for which your organization is licensed and to which you have security 
rights displays in the menu bar. From these menu options, you can access all module-
specific tasks (e.g., General Ledger > Journal Entries > New). In addition, you will 
use the menu bar to access specific program tasks (e.g., changing the business date):

• File—Open divisions; access Print Manager, Report Manager, or Financial 
Institutions.

• Edit—Change the business date or your password.
• View—View or close Navigator bar; view full or abbreviated menu names; 

view logged in users.
• Window—See all currently open windows, switch between these windows.
• Help—Access online help for the current module and program information. 

KEYBOARD NAVIGATION

To help you navigate quickly through the program, FundWare allows you to use your 
keyboard instead of your mouse to access program tasks.

• Menu bar—You can access any task listed on the menus using a combination of 
the ALT key and a letter and the arrow keys.
— Press the ALT key.
— Press the underlined letter of the item to display the menu. The menu 

displays.
— Use the arrow key and press ENTER to select a task.

• Shortcut menus—Access any applicable shortcut menus (normally displayed 
when you right-click your mouse) from the keyboard by pressing either 
SHIFT+F10 or the Application key (offered on many newer keyboards, located 
between the WINDOWS key and the CTRL key, to the right of the spacebar).

• Shortcut keys—Shortcut keys combine the CTRL key with a letter to give you 
direct access to certain tasks. These shortcuts are listed on the menus with the 
applicable tasks. 

• Drop-down lists—You can access any drop-down list when focus is on the 
associated field by using a combination of the ALT key and the down arrow key. 
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IS YOUR MENU BAR TOO CROWDED?

If your organization is licensed for a number of FundWare modules, your menu bar may 
be too wide to use conveniently. You can change the module names that are listed in the 
menu bar to display as acronyms, which will decrease the width of the bar:

• Select View > Abbreviated Menu Names from the menu bar. To change back, 
select View > Full Menu Names from the menu bar.

HOW YOUR SECURITY RIGHTS IMPACT THE MENU BAR

Your individual security rights may impact the modules and tasks that you see on the 
menu bar. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the menu bar.

• If your security settings allow you to access some, but not all, tasks in a module, 
the restricted tasks will not be listed in the menu bar.

USING THE NAVIGATOR BAR

The Navigator bar provides you with quick, mouse-driven access to your modules, 
module tasks, and currently open windows through two areas:

• Module navigator, and
• Open windows navigator.

You can resize the Navigator bar to meet the needs of your display by using your mouse 
to click on the right frame of the bar and drag the frame to the position you want. You 
can also hide or show the Navigator bar using the options on the View menu. Select the 
option to hide or show the bar, as applicable. These settings will be retained by the 
system when you close FundWare.

MODULE NAVIGATOR

The module navigator lists the modules for which your organization is licensed (unless 
your individual security settings do not allow you to access a module). When you click a 
module (it just takes a single click), the module expands to display all of the associated 
module tasks. 
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Accessing any of the tasks within the module takes another single click on the specific 
item. Some tasks are “nested” below a title. A single click will expand the title, 
displaying the related tasks below. 

Figure 1.21—Module Navigator—Expanded Menus

If your security settings restrict your access to specific tasks, those tasks will not 
be listed in the menu bar. 
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OPEN WINDOWS NAVIGATOR

The open windows navigator lists the windows that are currently open in this instance of 
FundWare, highlighting the window currently displayed. A single click of an entry in 
the open windows navigator redisplays the window in your workspace. 

Figure 1.22—Open Windows Navigator

As with all Windows applications, the more FundWare windows that you open 
concurrently, the greater impact to your processor speed. You can use the Open 
Windows Navigator to monitor how many windows you have open at any one 
time.

HOW YOUR SECURITY RIGHTS IMPACT THE NAVIGATOR BAR

There is no security impact to the open windows navigator. If your security rights 
allowed you to open a task, then that window will display in the open windows 
navigator. However, your individual security rights may impact the modules and tasks 
that you see on the module navigator. 

• If your organization is licensed for a module, but your individual security 
settings do not allow you to access any tasks in that module, the module will not 
be listed in the module navigator.

• Any tasks within a module from which you are restricted will not be listed in the 
menu bar. 

CUSTOMIZING YOUR DISPLAY

Throughout FundWare, you will encounter forms (similar to a table or spreadsheet) that 
allow you to customize the display through the shortcut menu (accessed by right-
clicking your mouse) or through direct manipulation with your mouse. Most of these 
settings are retained with your user name. Therefore, the forms display according to 
your settings wherever you log in to FundWare. (In other words, the program 
remembers how the form displayed when you closed FundWare. This is how it will 
display the next time you open the program.)
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Not all forms provide these options. If you attempt one of the customization 
options described here and are unsuccessful, it is likely that the option is not 
offered on that form.

HIDING AND DISPLAYING COLUMNS

To add or remove a column from a form, hover your mouse over the pane and right-
click. A shortcut menu displays, which allows you to hide or display columns from the 
form. 

Figure 1.23—Example Shortcut Menu for the GL New Journal Entry Form

The columns currently displayed in the form are indicated with a check mark. Select a 
column from the shortcut menu to add or remove that column to the detail pane.

If you have disabled fields through the module setup (e.g., the Accounts 
Payable parameter or stage settings), the associated column will not be listed on 
the shortcut menu.

RE-ORDERING THE COLUMNS

To re-order the columns in a form, “drag and drop” the column by clicking the column 
heading and moving the column to the desired position (holding the mouse button 
down).

In this example, the Account column is disabled 
because this column must always display. 

The remaining columns are currently displayed in the 
New Journal Entry form.
Some FundWare Basics 
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RESIZING THE COLUMNS

To resize a column, hover your mouse over the column border until the icon changes. 
Figure 1.24—Mouse Icon

Click your mouse button and drag the column border until it is the desired width.

SORTING THE ENTRIES IN A FORM

To resort the entries in a form, click the heading of the column on which you want the 
sort based. To reverse the sort order, click the column heading again. 

Figure 1.25—Sorting the Detail Pane

Sort order is not retained when you close FundWare.

HELP

If you encounter questions or problems while you are working in the program, you can 
access the online help from the Help menu (on the menu bar) or by clicking F1 to access 
the online help for the current module.

Original display.

Entries resorted 
based on Obligation 
number.

Entry order reversed.
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You can also access PDF files (portable document format) of the guides from your 
server:

• FundWare\Data\User Documentation
You must have Adobe Acrobat Reader installed to view the files. This program is 
available from the FundWare CD or as a free download from www.adobe.com.

TRAINING AND CONSULTING SERVICES

Blackbaud, Inc. offers a number of options to help you improve your use of FundWare.
• Regional classes—Training classes held several times per month in various 

cities across the nation. These one- to five-day classes provide a hands-on 
learning environment and low student-to-instructor ratio.

• eClasses—Interactive training classes offered over the Internet provide you and 
your staff the opportunity to receive training from FundWare experts without 
leaving your desk.

• Onsite custom training sessions and consulting—Our training/consulting group 
offers you onsite services, including:
— Training your staff using your data.
— Installing/upgrading and configuring the software to meet the specific needs 

of your organization.
For more information about any of our training or consulting services, please explore 
our Web site (www.fundware.com/Products_Services/Training/train.asp) or contact 
our Client Sales department (800-551-4458).

USING THIS DOCUMENT

This manual is organized to reflect the most common uses of the module. It provides 
you with overview information of FundWare, followed by specific features and 
functions of the module.
Some FundWare Basics 
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CONVENTIONS

Use Table 1.1 as a reference for conventions used in this document. 

GETTING SUPPORT

The following table provides a quick reference for getting the support you need for 
FundWare modules.

Table 1.1—Icon Conventions
Indicator Description

A caution or warning that must be heeded. Information contained in a warning should be care
reviewed to avoid adverse affect on software operation.
An example, used to clarify an issue.

ENTER Keyboard directions are indicated in small capital letters (e.g., Press ENTER).
demo user Specific text entries are indicated with italics (e.g., Type demo user for User Name).
Click OK An item on the screen that requires user interface is indicated in bold.

Table 1.2—Getting Support
Department Contact Description

Business 
Office

800-551-4458 Obtain general information or contact a sta
member.

Technical 
Support

800-227-7575
e-mail: FWSupport@Kintera.com

Get help resolving technical issues with th
product. Please have the following informa
ready when you call:
• FundWare license number
• FundWare version number
• Error message details

Knowledgebase
http://www.FundWare.com/Support/
support.asp

A searchable database where you can typ
your questions and get a list of possible 
answers.
• Requires your license number and web 

password.
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Training 800-551-4458
Ask for the Client Sales department.
http://www.FundWare.com/
Products_Services/Training/train.asp

Contact us for more information on our trai
options:
• Regionals—Classes from 1 to 5 days in 

length; held in cities around the country.
• eClasses—Two- to three-hour classes of

over the Internet.
• Onsite custom training and consulting—O

consulting staff can implement FundWar
and/or train your employees using your 
organization’s data.

Replacement 
Software

800-551-4458 or 303-756-3030, 
Ask for the Client Sales department.
e-mail: FWSupport@Kintera.com

Order replacement software.

Product 
Management

e-mail: FWSuggestionBox@Kintera.com Contact our Product Management departm
with any suggestions for improving FundW

User 
Education

e-mail: FWUserEducation@Kintera.com Contact our User Education department w
suggestions for improving our user guides 
online help.

World Wide 
Web

http://www.FundWare.com Get the latest product and company 
information, download software and 
documentation updates, or send e-mail.

Blackbaud, Inc.
6430 S. Fiddler’s Green Circle, Suite 200
Greenwood Village, CO 80111
800-551-4458
303-756-3030

Table 1.2—Getting Support (Continued)
Department Contact Description
Some FundWare Basics 
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ADDING AND MAINTAINING EMPLOYEES

Your employee records contain basic data like address and phone number, as well as all 
applicable payroll and accounting information, and are accessed from the Employees 
folder. This folder stores all employees at the main level (i.e., the Employees folder 
level). However, “subfolders” divide the employees by status. Therefore, all your active 
employees can be found in the Employees folder and in the Active subfolder. 
The employees display in the data area to the right. Below the employee records, buttons 
show the actions you may perform here (Figure 2.1). If an action is not available at a 
certain point in the payroll process, or if your security rights do not allow you access to 
a task (e.g., you can add but not edit employee records), the button will be disabled. 

Figure 2.1—Payroll Buttons

ADDING EMPLOYEES
Use the following steps to add a new employee.

Add a new 
employee record

Edit existing 
employee information

Create a group of 
timesheets

Create a single 
timesheet
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1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees folder or the Active subfolder. The records stored in the 
folder display in the detail pane.

3. Click Add or right-click and select Add Employee from the pop-up list. The 
Employee Information window displays, open to the Name and Address tab 
(Figure 2.2). 

Figure 2.2—Employee Record—Name and Address Tab

4. Complete the fields on the Name and Address tab according to Table 2.1. 

Table 2.1—Field Definitions for the Name and Address Tab

Field and EDI Definition

Employee (Number) 
(.EMPLOYEE)

The system can be set to assign an employee number to each new 
employee automatically.
Adding Employees 



Chapter 2—Adding and Maintaining Employees
5. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

COMPLETING THE PERSONAL INFORMATION TAB

Use the following instructions to complete the Personal Information tab of the 
employee record.

Name • No restrictions other than size.

• First (.NAME FST) • Type the employee’s first name. The first 18 characters print on the 
check. Maximum characters = 30. 

• Middle (.NAME MI) • Type the employee’s middle name. The first character prints on the 
check. Maximum characters = 10.

• Last (.NAME LST) • Maximum characters = 30. Up to 30 characters print on the check, 
depending on the length of the first name and middle initial. The total 
number of characters printed on the check for the first name, last name, 
and middle initial is 40.

Address No restrictions other than size.

• Street 1 (.ADDR1) • Type the street address. The first 40 characters print on the check. 
Maximum characters = 55.

• Street 2 (.ADDR2) • Type the rest of the street address in this optional field. The first 40 
characters print on the check. Maximum characters = 65.

• City (.CITY) • Type the city. The first 25 characters print on the check. Maximum 
characters = 30. 

• S/T/P (.STP) • Type the first 2-3 characters of the state, territory or province. Only these 
characters print on the check. Maximum characters = 10.

Postal Code (.POSTAL) Enter the zip or postal code, with a hyphen separating the expanded postal 
code (for example, 80030-52144). All 10 characters print on the check. 
Maximum characters = 20. 

Country (.COUNTRY) Type the country. Maximum characters = 30.

Table 2.1—Field Definitions for the Name and Address Tab (Continued)

Field and EDI Definition
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1.  Select the Personal Information tab (Figure 2.3). 

Figure 2.3—Employee Record—Personal Information

2. Complete the fields on the Personal Information tab according to Table 2.2. 

Table 2.2—Field Definitions for Personal Information Tab

Field and EDI Definition

Dates Must be valid numeric dates.

• Birth (.DOB) • Format = mm/dd/yyyy.

• Hire (.DOH) • Format = mm/dd/yyyy.

• Last Review (.DOR) • Format = mm/dd/yyyy.

• Probation (.DOP) • Enter either the first or last date of a probationary period. Format = mm/
dd/yyyy.

• Termination (.DOT) • Enter the date of termination. Format = mm/dd/yyyy. 

Phone Numbers Phone numbers must be numeric and contacts must be alphanumeric.
Adding Employees 
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3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

COMPLETING THE PAYROLL INFORMATION TAB

Use the following instructions to complete the Payroll Information tab of the employee 
record.

• Home (.PHONE HME) Enter the employee’s home phone number, including the area code. Format 
= (999) 999-9999.

• Emg contact 
(.CONTACT E)

Type the name of the person to contact in case of an emergency. Maximum 
characters = 30.

• Emergency 
(.PHONE EMG)

Enter the phone number of the emergency contact person. Format = (999) 
999-9999. It will format automatically for you.

• Alt contact 
(.CONTACT A)

Enter the name of a different person to contact in case of an emergency. 
Maximum characters = 30.

• Alternate phone 
(.PHONE ALT)

Enter the phone number of the alternate contact person. Format = (999) 
999-9999. It will format automatically for you.

Personal Information

• Gender (.SEX) • Click the drop-down arrow and choose Not Used, Female, or Male. 

• Soc Sec No (.T TID) • Enter a U.S. Social Security Number, Canadian tax ID number, or other 
tax identification number. Maximum characters = 30. Hyphens are 
optional.

Table 2.2—Field Definitions for Personal Information Tab (Continued)

Field and EDI Definition
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1.  Select the Payroll Information tab (Figure 2.4). 

Figure 2.4—Employee Record—Payroll Information

2. Complete the fields on the Payroll Information tab according to Table 2.3. 

Table 2.3—Field Definitions for the Payroll Information Tab

Field and EDI Definition

Payroll Status—Defines the employee with status codes.

• Employ Status 
(.STATUS)

Click the drop-down arrow and choose the Employment Status:
• Active
• Leave (for On Leave)
• Terminated
While you can add status values by adding edit values to the .STATUS 
employee data item, only employees with a status of Active are included in 
group timesheets and only employees with a status of Terminated are 
removed when you purge history. We recommend that you use the 
.STATUS P employee data item to customize status information. Entering 
Edit and Lookup Values on page 1.123.
Adding Employees 
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3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

• Payment Status 
(.STATUS P)

Click the drop-down arrow and choose: 
• Not used
• Full-time hourly
• Full-time salary
• Part-time hourly
• Full-time salary
• Seasonal
These are system defaults; you can change these or add to the list in setup; 
however, any customized settings are overwritten when you update from 
the ToolBox.

• Pay Frequency 
(.T FREQ) 

This is the number of pay periods in a calendar year. Click the drop-down 
arrow and choose:
• Bi-weekly (26 times per year)
• Monthly (12 times per year)
• Semi-monthly (24 times per year)
• Weekly (52 times per year)
These are system defaults; you can change these or add to the list in setup.

Payroll Information—Defines the dollar amounts and accounting information for employee earnings.

• Home (.HM DEPT) Click the drop-down arrow and choose the employee’s home department. 
This field is used for sorting purposes only.

• Salary (.S AMT) An employee must have at least one Salary, Hourly, or Other rate, and may 
have more than one. In this field, enter the flat dollar amount of salary per 
pay period, if applicable.
• If the Payroll parameter defines Salary as classified (field 1), select the 

salary option from a drop-down list.

• Hourly rate (.H AMT) Enter the per-hour rate of pay, if applicable.
• If the Payroll parameter defines Hourly as classified (field 1), select the 

salary option from a drop-down list.

• Other rate (.O AMT) Click the drop-down arrow and choose the employee’s per-unit rate of pay, 
if applicable.
• If the Payroll parameter defines Other as classified (field 1), select the 

salary option from a drop-down list.

Table 2.3—Field Definitions for the Payroll Information Tab (Continued)

Field and EDI Definition
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COMPLETING THE ACCOUNTING INFORMATION TAB

Use the following instructions to complete the Accounting Information tab of the 
employee record. (You will use this tab only if your payroll process is 
departmentalized.)

1.  Select the Accounting Information tab (Figure 2.5). 

Figure 2.5—Employee Record—Accounting Information
Adding Employees 
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2. Complete the fields on the Accounting Information tab according to Table 2.4. 

3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

Table 2.4—Field Definitions for the Accounting Information Tab

Field and EDI Definition

Department Earnings

Hourly rate, Salary, or 
Other rate

Select the radio button under Department Earnings to choose Hourly, 
Salary, or Other for the type of earnings. 
Click Add to begin entering information.

• Hourly or Salary: % 
Expensed (.H PCNT, 
.S PCNT)

• Enter the percentage rate of wages going to the department and General 
Ledger account (GLA). Note that 50% is entered as 50.00. The entries 
should total 100%. 

• Hourly or Salary: 
Salary or Hourly dept 
(.H DEPT, .S DEPT)

• Click the drop-down arrow and choose the Department against which 
these wages will be expensed.

• Hourly or Salary: GLA 
(.H GLA, .S GLA)

• Click the drop-down arrow and choose a General Ledger Account edit 
value. Typical entries include:
— Not used
— Salaried
— Seasonal

• Hourly or Salary: Addtl. 
basis for (.H GRP, 
.S GRP)

• Click the  button to choose additional taxes and/or deductions which 
the earnings amount is subject to that are not already defined for the 
earnings historical data item. These data items are used in addition to 
what is defined for the earning historical data item. You must use a 
defined historical data item. To select a data item, see Additional Basis 
Earnings on page 2.40.

• Other Rate: Hourly 
dept. (.O DEPT)

• Click the drop-down arrow and choose the Department against which 
these wages will be expensed. 

• Other Rate: GLA 
(.O GLA)

• Click the drop-down arrow and choose a General Ledger Account edit 
value.

• Other Rate: Addtl. 
basis for (.O GRP)

• Click the  button to choose additional taxes and/or deductions which 
the earning amount is subject to that are not already defined for the 
earning historical data item. These data items are used in addition to 
what is defined for the earning historical data item. You must use a 
defined historical data item. To select a data item, see Additional Basis 
Earnings on page 2.40. 
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ACCOUNTING INFORMATION TAB—ADDITIONAL TIPS

• Departmentalized Earnings are defined in the payroll parameters as being 
expensed to multiple departments. For each earning which you defined as 
departmentalized, you created a departmental table. 

• We strongly recommend that you define hourly, salary, and other settings when 
you enter an employee record, even if the employee currently only needs one 
setting. If at some point in the future you need this information for the 
employee, the information will be defined already.

• To delete a line, point to the gray area in the line next to the % Expensed 
column, and click Delete.

ADDITIONAL BASIS EARNINGS

Click on a data item from the Available list, then click the right arrow to move the data 
item to the Selected list (Figure 2.6). The double right arrow moves all Available data 
items to the Selected list. The left arrow buttons reverse the process.

Figure 2.6—Additional Basis for Earnings

Remember: These data items are in addition to the basis defined on the earnings 
historical data item.

COMPLETING THE DIRECT DEPOSIT TAB

Before configuring employees for direct deposit, you should review the setup 
information in Chapter 6—Defining Direct Deposit on page 1.183. If you system is 
already configured for direct deposit, use the following instructions to complete the 
Direct Deposit tab the employee record.

This tab will not display if the Payroll parameter is not defined for electronic 
fund transfer (field 2).
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1.  Select the Direct Deposit tab (Figure 2.7). 

Figure 2.7—Employee Record—Direct Deposit

2. Complete the fields on the Direct Deposit tab according to Table 2.5. 

Table 2.5—Field Definitions for the Direct Deposit Tab

Field and EDI Definition

Inactive, Active, or Pre-
notification (.EFT ACT)

Select the radio button under Direct Deposit to choose the status for this 
employee:
• Inactive—This employee is not active in the direct deposit program.
• Active—This employee is active in the direct deposit program.
• Pre-notification—This employee is in pre-notification for the current pay 

cycle, and will receive a regular check. The Payroll Administrator must 
change this field to Active after the pre-notification is submitted. 

Selection (.EFT SEL) If you are using more than one bank for Direct Deposits, click the drop-
down arrow to choose the appropriate box. This option allows you to 
complete the direct deposit process separately by financial institution.
• If you have only defined one bank, this field will say Not Used.
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Line Entry Line numbers control the order in which information is processed. Enter a 
2-digit line number. 
• We recommend that you number lines 10, 20, 30, etc., and number the 

last line 99. 
• If the employee is directing their check to be deposited to one account, 

they will only have line 99. 

Cycle (.EFT CYCLE) Click the drop-down arrow and choose the appropriate Direct Deposit 
Cycle. Cycles are activated in the Preliminary Check Register or when 
producing checks, and determine when the direct deposit occurs. 

Type (.EFT APR) Click the drop-down arrow and choose the amount type:
• Amount—A flat amount.
• Percentage—A percentage of net pay. 
• Remainder—The remaining amount after all previous lines have been 

processed. All active or pre-note direct deposits must have the last line of 
their direct deposit information be a remainder line. 

Transfer Type (.EFT DP) Click the drop-down arrow and choose the type of direct deposit:
• Checking Deposit—A credit to a checking account. 
• Deposit—A credit to an account. 
• Checking Pre-notification—A pre-notification for zero dollars for a 

checking account. (Use only when an active direct deposit employee 
directs a change to his/her direct deposit.)

• Payment—A debit to a loan or mortgage account.
• Payment Pre-notification—A pre-notification for zero dollars for a 

payment.
• Savings Deposit—A credit to a savings account.
• Savings Pre-notification—A pre-notification for zero dollars for a savings 

account. Use only when an active direct deposit employee issues a 
change.

Amount/Percent 
(.EFT NBR)

If you chose Amount in the Transfer Type field, type in the amount here. If 
you chose Percentage, enter the percentage here. If you chose Remainder, 
enter zero here.

Bank DFI Number 
(.EFT DFI)

The bank’s Depository Financial Institution number. Enter the number, 
which must be at least 8 digits, including any leading zeros. Do not enter 
the 9th digit in a bank number; it is a check digit.

Bank Account Number 
(.EFT ACCT)

The employee’s bank account number. Maximum characters = 30.

Table 2.5—Field Definitions for the Direct Deposit Tab (Continued)

Field and EDI Definition
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3. To save your work and remain in the employee record, click Apply. Clicking 
OK will save your work and close the employee record.

DIRECT DEPOSIT TAB—ADDITIONAL TIPS

• The lines are processed “top down”, so the lines with the highest priority should 
be entered first. In some cases, the later lines cannot be processed because of a 
lack of dollars.

• A line can be either a deposit or a payment. A deposit normally increases the 
balance of a checking or savings account and is considered a “credit” to the 
bank. A payment normally decreases the balance of a liability account like a 
mortgage or loan, and is considered a “debit” to the bank.

• Direct Deposit Cycles control when a payment or deposit is made. Cycles can 
be a number between one and nine. If all employees make the same deposits/
payments every pay period, cycles are not needed. But if any payments are 
made every other pay period or only on designated dates, cycles must be used.

• In addition to completing this tab, we strongly recommend that you create pre-
notification file and send it to the bank. A pre-notification is a record sent to the 
employee’s bank to verify routing transit numbers and account numbers. Check 
with your financial institution for specific information regarding the number of 
banking days you must do the pre-note before the first Direct Deposit can be 
done.
Only pre-notes are produced in this file, and it can be produced at any time. It 
can also be used for active Direct Deposit employees who are being pre-noted 
for a new account.

COMPLETING THE PAY CALCULATION TAB

Use the following instructions to complete the Pay Calculation tab of the employee 
record. This tab stores any user-defined EDIs that you add to the employee record 
(automatically or manually).
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1.  Select the Pay Calculation tab (Figure 2.8). 

Figure 2.8—Employee Record—Pay Calculation

Any employee data items automatically added to employee records 
(field 3 of the EDI definition) will display on the Pay Calculation tab. 

2. Complete the fields on the Pay Calculation tab according to Table 2.6. 

Table 2.6—Field Definitions for the Pay Calculation Tab

Field Definition

Data Item Click Add to add an additional data item. Whatever data items have been 
set up for the organization will appear here automatically. To delete a data 
item, select the line and click Delete.
• You add the Normal Hours Worked data item to this tab (.H HRS) and 

enter the normal hours that the employee works in a pay period. When 
you create group timesheets for hourly employees, you can tell Payroll to 
look to the Normal Hours Worked defined on each employee’s record. 
See Creating Timesheets for a Group of Employees on page 2.66 for 
more information on this feature.

Value Depending on the type of data item you chose, either type in the value or 
choose the appropriate value from a drop-down menu.
Adding Employees 
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For more information on the earnings data items (e.g., costcode, 
distribution table, departmentalized earnings), see Implementing 
Costcodes on page 1.46, Creating Distribution Tables on page 1.67, and 
Creating Departmentalized Earnings on page 1.72.

3. When you have finished all tabs, click OK to save the information and return to 
the main menu.

PAY CALCULATION TAB—ADDITIONAL TIPS

• An employee data item is a field that allows you to add information to employee 
records. Common data items include .MARITAL, .FICA TAX, .FWT EXEMP, 
etc. For more information on creating data items, see Chapter 3—Using Data 
Items on page 1.77. 

• Values (i.e., edit values) are defined for some data items. If a data item has no 
value restrictions, such as employee names and addresses, it does not need edit 
values. A data item such as .MARITAL needs to be restricted to Married or 
Single. A .FICA TAX data item can only be Yes or No. Using edit values makes 
employee records easy to maintain because any necessary changes to the values 
are made in only one place, rather than on every record.

EDITING EMPLOYEES
Use the following steps to edit an existing employee.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees folder or the applicable subfolder (e.g., Active). The 
records stored in the folder display in the detail pane.

3. Select the desired employee.

4. Click Edit or double-click the employee.

5. Click the appropriate tab and enter your changes

6. Click OK to save those changes and return to the Payroll/Personnel main 
window. 

For detailed instructions on completing each field, see Adding Employees on page 2.31.
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CHANGING EMPLOYEE STATUS
An employee cannot be “deleted” from Payroll/Personnel. However, you can change an 
an employee’s status (e.g., from active to on leave, from active to terminated, from on 
leave to active). (If you wish to permanently purge employees, see Purging Data on 
page 1.237.)

Timesheets are created only for employees who have active status!

Use the following steps to change an employee’s status.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees folder or the applicable subfolder (e.g., Active). The 
records stored in the folder display in the detail pane.

3. Select the employee.

4. Click Edit or double-click the employee.

5. Select the Payroll Information tab.
Changing Employee Status 
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6. Select the new status from the Click the Employ Status drop-down menu 
(Figure 2.9). 

Figure 2.9—Employee Status Drop-Down Menu

7. Click OK. The employee’s status changes and the employee record moves to 
the applicable subfolder.

ENTERING EMPLOYEE HISTORY
You may wish to enter historical information for employees to create a “history” check. 
You can:

• Enter year-to-date check information for employees if you are starting to use 
Payroll/Personnel in the middle of the calendar year. 
— You must enter the historic information before beginning your regular 

payroll operation. Several calculations (e.g., FICA) require year-to-date 
basis information to calculate accurately. Remember to enter history for 
“Other” type historical data items (e.g., employer’s share of FICA, federal, 
and state unemployment taxes; employer-paid benefits).
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• Enter adjustments, such as corrections to basis hours or amounts. These entries 
do not impact General Ledger.

You will enter the historical information using a history date, which is used to determine 
the reporting period in which the information is included. For example, entries using 6/
30/04 are included in quarter-to-date history for the second quarter and half-year history 
for the first half of the year. You can print this historical information with the Check 
History Report (see Appendix B—Sample Reports on page 2.225) or a customized user-
defined report.
When entering Employee History, you will be prompted for a batch total (the net total of 
the checks) for the group of transactions to be entered. Once you have entered the entire 
batch of transactions, the Balance to go amount should be zero. If not, a net amount may 
be incorrect or missing, or the batch total may be incorrect.
Use the following steps to enter employee history.

1.  Click Transaction Entry > Enter Employee History on the module navigator 
(if the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Transaction Entry > Enter Employee History from the menu 
bar. The task window displays asking you to enter the batch total (i.e., the net 
total of the checks) for the group of transactions to be entered (Figure 2.10). 

Figure 2.10—Enter the Batch Total

2. Enter the net total of checks that you wish to process. You may leave this field 
blank by pressing ENTER. Let the system calculate the total, and enter it before 
posting the batch.
Entering Employee History 
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3. Press ENTER. As you complete each of the required fields on page 1, the next 
field is revealed (Figure 2.11).

Figure 2.11—Enter Employee History, Page 1 of 2

Complete the fields on the first page of the task according to Table 2.7. 

Table 2.7—Enter Employee History—Page 1 of 2

Field Valid Entry Definition

Employee #—number The number of the employee for whom history is being 
entered. Press F1 to look up an employee number. You 
can scroll employees in number order or alphabetically by 
last name.

History 
date

99/99/9999 This date is used to determine the periods to include this 
history in for monthly, quarterly, and half-year reports.
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4. Enter each data item for this history (Figure 2.12). Basis amounts must be 
entered for tax reporting data items. 

Figure 2.12—Enter Employee History, Page 2 of 2

Net 
amount

$—amount or <blank> The net check amount. If the history did not affect an 
employee check, press ENTER to leave the net amount 
zero. For example, accrued vacation hours and employer 
cost items, such as the employer share of FICA, do not 
affect employee checks.
The net check amount must equal the total of all earnings 
entered less taxes and deductions before an entry can be 
added.

Entry 1–99999 A number for the data item within the history check. Each 
history item must have a unique number. Up to 99,999 
pieces of employee history can be entered under one 
history check. Press ENTER to allow the system to 
automatically number entries.

Table 2.7—Enter Employee History—Page 1 of 2 (Continued)

Field Valid Entry Definition
Entering Employee History 
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5. Complete the required fields according to Table 2.8.

All Data Items relating to this history check are entered in Entry field (Figure 
2.13).

Figure 2.13—Example Data Items

6. When complete (i.e., the balance to go = 0.00), press ESC to display the option 
menu and type E to end the session.

Table 2.8—Enter Employee History—Page 2 of 2

Field Valid Entry Definition

Data Item Historical Data Item name The name of the Data Item for which history is to be added.

Hours/units R—rate The number of hours or units. This is an optional field. 
Press ENTER to leave it blank.

Amount $—amount The amount for this Data Item. Press ENTER to leave it 
blank.

Basis hrs/
units

R—rate The number of hours or units on which this Data Item is 
based. For example, vacation time may be based on the 
number of hours worked. Press ENTER to leave it blank.

Basis 
amount

$—amount The amount on which this Data Item is based. For 
example, the basis for FICA is dollar amount of total 
earnings. Basis amounts are used in production of year-
end tax forms and must be entered correctly. Press ENTER 
to leave it blank.
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7. The checks are stored in the PYEHIST report. Print this report to produce your 
checks.

8. File a printed copy of the report for your audit trail.

USING THE EMPLOYEE SELECTOR
Many tasks in the Payroll/Personnel module use a filter that allows you to define the 
employees, records, or transactions to include on a report or in a task, as well as preview 
your results. This feature is called the “Employee Selector”. If you don’t enter criteria in 
the Employee Selector, all tasks and reports will be processed in ID order for all 
employees. 
The Employee Selector appears when you perform the following tasks:

• Employees folder and subfolders:
— Create Group Timesheets

• Timesheets folder:
— Create Group Timesheets
— Post Timesheets

• Net Pay Calculations folder: 
— Calculate Net Pay
— Check Writing

Use the following instructions to complete the Employee Selector.
1.  Scroll through the list of employee data items and select the applicable data 

item, or type the data item name (Figure 2.14). For example:

• .NAME LST—Generates an alphabetical list of employees by last name.
• .HM DEPT—Generates a list of employees who work in specific 

departments.
• .DOH—Generates a list of employees by date of hire. 
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• .STATUS P—Generates a list of full-time or part-time employees. 

Figure 2.14—Employee Selector—Selecting an Employee Data Item

As you select a data item, the First Value and Last Value fields will reflect the 
format of information required, as appropriate (e.g., date format).

2. Enter the First and Last Values to limit the information returned. For example, 
select only employees hired in a six-months period (e.g., from January 1, 2004 
through July 1, 2004):

• Choose .DOH in the Data Item. 
• Enter the beginning date for the period (e.g., January 1, 2004) as the First 

Value.
• Enter the ending date for the period (e.g., July 1, 2004) as the Last Value. 
• Last Value—The employee data item used to expand the information 

returned. Enter F SALARY as the Second Value.
To get all values, skip the First Value and Last Value fields and click 
Add.

If the Entry Range (Recurring Data Items Only) area is enabled, you 
have selected a data item with multiple entries (i.e., multi-occurring 
data items). Please refer to Selection Mode on page 2.56 for instructions 
on this area.

3. Select the applicable Include or Exclude radio button to refine your criteria.
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By default, the records within the range of the First Value and Last 
Value will be included (i.e., the employees who fall within this range 
will be included in the task). However, you can also use this range as an 
exclusionary filter (i.e., the employees who fall within this range will be 
excluded from the task). 

4. Click Add to add the selection the Employee Selector criteria. The details of the 
criterion are shown in the Display Area (Figure 2.15). 

Figure 2.15—Employee Selector—Adding the Data Item Values
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5. Click Preview to view the employees included in your selection. The 
employees display in the Search Results area (Figure 2.16). 

Figure 2.16—Employee Selector—Search Results

If you have very large groups of employees (for example, 4,000), the 
execution may take a few seconds.

6. Click OK to apply your selection criteria.
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SELECTION MODE

When salaries are departmentalized, data items such as .S AMT, .S DEPT, .S GLA, .S 
GRP and .S PCNT are defined as multiple entry fields (i.e., Payroll allows you to enter 
multiple definitions for your salary, hourly, or other settings). Each line of salary 
information for an employee is stored separately. When you select a multiple entry data 
item, the system displays an additional field called Selection Mode (Figure 2.17). 

Figure 2.17—Employee Selector—Selection Mode

Selection Mode allows you to require that: 
• All of the values in the specified range are present for it to be included or 

excluded; or 
• If any of the values in the range is present, the employee is included. 

For example:
• You want a list of employees who receive their salary from either the Sales or 

the Marketing Department, so you select the Any May Be True radio button.
• You want a list of employees who receive part of their salary from every 

Department, so you select the All Must Be True radio button.
Use the following instructions if you are entering the criteria for your Employee 
Selector and the Selection Mode is displayed.

1.  Enter the first and last value in the From and To fields.

2. Select the applicable radio button (All Must Be True or Any May Be True).
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3. Click Add and continue enter your Employee Selector criteria.

ADDING INFORMATION TO THE SEARCH RESULTS

The Employee Selector allows you to modify the information displayed in the Search 
Results area.

1.  Click Data Items. The Select Data Items window displays. 

2. Select the data item to add to the Search Results area (Figure 2.18). 

Figure 2.18—Selecting Data Items

3. Click OK. The information is added to the display (Figure 2.19). 

Figure 2.19—Data Items Added to the Search Results
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C H A P T E R  3

ADDING AND MAINTAINING TIMESHEETS

All the setup tasks for Payroll/Personnel lead you to this point—creating timesheets for 
your employees. The timesheet process involves three easy steps:

1.  Enter timesheet information for one or more active employees. 

2. Verify the accuracy of the information on the timesheet (i.e., the correct basis 
amounts and valid GL account numbers). 

3. Post the timesheets to the next stage of the process: calculating net pay.

As you define each portion of a timesheet (e.g., earning items, distribution tables), 
Payroll “builds” the account number. (See Departmentalization, Costcodes, and 
Distribution Tables on page 1.2 for more information on this process.) Any problems as 
the account number is built are reflected on the timesheet and in the timesheet detail 
pane.
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For example, Figure 3.1 shows an account error message. 

Figure 3.1—Example Timesheet With Account Error

Once you have entered your timesheets and resolved any account issues, you have to 
verify that the basis amounts and account numbers are valid (e.g., does the account 
number exist). 

Basis is the dollar amount that an earning, tax, deduction, or employer cost is 
based on. For example, if an employer’s share of FICA is $76.50, it has a “basis 
amount” of $1,000 in earnings.

Once you have verified that the timesheets have no errors (or you have corrected and 
reverified the timesheets), you are ready to calculate the net pay. This step is discussed 
further in Chapter 4—Calculating Net Pay on page 2.83. 
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WHAT MAKES A TIMESHEET?
A timesheet is a single record that stores all of the current earnings items (or “line 
items”) for an employee. Each earnings item that you use may require different 
information, based on the item definition:

• The earnings item may require a flat dollar amount (e.g., a $1,500 bonus for an 
employee).

• The earnings item may calculate a dollar amount based on hours or work 
performed (e.g., 40 hours in a week for an hourly employee). 

• The earnings item may be defined by hours, not dollars (e.g., an employee takes 
16 hours of sick time).

Once you save a timesheet entry, this information is stored as a timesheet and combined 
with any other current timesheet entries for the employee.
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ANATOMY OF A TIMESHEET

Each single timesheet is comprised of three areas where you add timesheet entries, 
select basis details for each entry, and resolve account issues (Figure 3.2). 

Figure 3.2—Example Single Timesheet
What Makes a Timesheet? 
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TIMESHEET ENTRY AREA

The timesheet entry area is a grid in which you add your earnings items (Figure 3.3). 
(Remember, your earnings items are the historical data items defined as History type—E 
[Earnings] in field 1 of the historical data item record. See Defining Historical Data 
Items on page 1.85 for more information on this definition.) 

Figure 3.3—Example Timesheet Entry Area

The availability of the cells in this grid will reflect your selections. For example, in 
Figure 3.3 the Salary earnings item for this employee only requires amount and rate 
item information. Therefore, the other cells in this line are disabled.

BASIS DETAIL AREA

The Basis detail for selected line area provides information concerning the basis detail 
selections for the earnings item and the employee. Additionally, any messages 
concerning these selections display in the Invalid Basis box (Figure 3.4). 

Figure 3.4—Example Basis for Selected Line Area
Blackbaud, Inc. 2.63



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.64
If field 4 of the earnings item definition indicates that change is not allowed, the 
area title (Basis detail for selected line) is disabled and you cannot to modify 
any of the basis selections. 

The items selected in the Basis detail are defined in one of the following locations:
• The Basis for field (field 4) of the historical data item (Figure 3.5) 

Figure 3.5—Example Earnings Item Basis Information

• The employee Accounting Information tab (Figure 3.6). 

Figure 3.6—Example Accounting Information Tab
What Makes a Timesheet? 
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ACCOUNT DETAIL AREA

The Account detail for selected line area displays the account number and description 
built by the selected timesheet entry (i.e., line item). Additionally, any messages 
concerning the account number built by the payroll process display in the Messages box 
(Figure 3.7). 

Figure 3.7—Example Basis for Selected Line Area

If field 4 of the earnings item definition indicates that change is not allowed, the 
area title (Account detail for selected line) is disabled and you cannot to modify 
any of the basis selections. 

WHAT ARE GROUP TIMESHEETS
If you have a group of employees with a fixed earnings amount, you can save time by 
creating their timesheets as a group. This option is especially useful when you are 
creating groups of timesheets for regular earnings, such as:

• Salaried earnings when wages are the same each pay period.
• Hourly earnings for employees who work a fixed number of hours each pay 

period.
• Holiday pay that is recorded for all employees.

You may wish to create a group of timesheets for 80 hours for all hourly 
employees, then edit the timesheets for those few employees who worked less 
than 80 hours.
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You can create group timesheets if you are using any of the following accounting 
methods (as defined in the Payroll parameter; see Defining the Payroll Parameter on 
page 1.34):

• Distribution tables, 
• Departmentalized earnings, or 
• Costcodes. 

GROUP TIMESHEETS AND THE EARNINGS ITEM

When you create group timesheets, you will select the fixed earnings item (e.g., salary) 
from a drop-down list. This drop-down list displays all “earnings items” defined for 
your system. (If the entry type [field 4] for the earnings item is defined for no timesheet 
entry or for proration, the earnings item will not display.)

Remember, your earnings items are the historical data items defined as History 
type—E (Earnings) in field 1 of the historical data item record. See Defining 
Historical Data Items on page 1.85 for more information on this definition.

CREATING TIMESHEETS FOR A GROUP OF EMPLOYEES
Use the following steps to create timesheets for a group of employees.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees or Timesheets folder (or an applicable subfolder). The 
records stored in the folder display in the detail pane. 

You can only create timesheets for active employees. Therefore, in all 
the Employees subfolders except Active, Group is disabled.
Creating Timesheets for a Group of Employees 
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3. Click Group. The Create Group Timesheets window displays (Figure 3.8). 

Figure 3.8—Create Group Timesheets

4. Select the applicable earning item from the drop-down list. If the earnings item 
requires an entry of hours or units, the check box for Use hours from employee 
record and text box for Hour/Units are enabled.

• Use hours from employee record—The system applies any non-zero 
amount defined for the Normal Hours Worked employee data item. (You 
must manually add this information to the Pay Calculation tab of the 
employee record.) 
— Payroll will not create a timesheet for any employee who does not have 

a definition for Normal Hours Worked, or the entry is zero.
• Hours/Units—The system applies the number of hours or units entered to 

all applicable employees.
5. If enabled, select the Use hours from employee record check box or enter the 

number of hours or units of work in the Hour/Units text box.

6. Ignore the Check Sequence field, if enabled. This field is not applicable in the 
current version of the software.

The Check Sequence field is enabled if you defined the Payroll 
parameter to allow multiple checks with the check sequence determined 
at the entry of the timesheet (i.e., Multiple Checks in field 2 of the 
parameter is defined as T—Check sequence determined at entry).
Blackbaud, Inc. 2.67



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.68
7. Click Employee Selector to identify the employees included in this group (or to 
further define employees if you selected the Salary or Hourly earnings item). 
The Employee Selector displays (Figure 3.9). 

Figure 3.9—Employee Selector

8. Enter your selection parameters. (For more instructions on the Employee 
Selector, see Using the Employee Selector on page 2.52.)

9. When you have completed your selections, click OK. The Employee Selector 
closes and you return to the Create Group Timesheets window.

10. Click OK. The program saves the timesheets to the Timesheets folder. 
Depending on the number of timesheets that you are creating, this process may 
take a few seconds. 

Clicking Cancel returns you to the main screen without generating 
timesheets.
Creating Timesheets for a Group of Employees 
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TROUBLESHOOTING

If you should accidentally generate timesheets twice for the same group of employees, 
they will receive one check with double pay. To fix this problem, edit the timesheets to 
correct the error, removing the additional earnings.

CREATING A SINGLE TIMESHEET
You may wish to create a timesheet for one employee at a time. Often single timesheets 
are used to add hours for an employee who used sick or vacation hours, to correct a 
timesheet that was created automatically, or when employee wage expenses change each 
week. Use the following steps to add a single timesheet.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees or Timesheets folder. The records stored in the folder 
display in the detail pane.
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3. Click Single. The Create Single Timesheet window displays (Figure 3.10). 

Figure 3.10—Create Single Timesheet

4. At Employee ID, enter the employee’s ID number in the first field and move to 
the next field.

If you accessed this form from the Employees folder, you can select the 
employee for which you are adding a single timesheet. When you click 
Single, the Employee ID is prepopulated with the selected employee.

Pressing ENTER from the Employee ID field will dismiss this form. Use 
TAB or your mouse to move to the next field.
Creating a Single Timesheet 
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5. Select the earnings item from the drop-down list. When you move off the 
earnings item cell, the applicable cells on the row will remain enabled while 
cells that are not need for the earnings item will be disabled (Figure 3.11). 

Figure 3.11—Example Timesheet With Disabled and Enabled Cells

Instead of selecting form the drop-down list, you can begin to type the 
earnings item name. The system will search for a match that you can 
select by pressing ENTER. This tip applies to all cells with a drop-down 
list.

To access any drop-down list from your keyboard, press ALT + the 
down-arrow key. You can use the up- and down-arrow keys and ENTER 
to select any option on the drop-down list. This tip applies to all cells 
with a drop-down list.

6. Enter the required information according to Table 3.1. (Again, some of these 
fields will be disabled, based on the needs of the earnings item.) 

Table 3.1—Timesheet Entry Fields

Field Description

Amt/Hrs/Units Enter the amount, hours, or units to apply to the earnings item. (Your entry can but 
does not have to include plus/minus signs, parentheses, or decimal points.) For 
example: 40 hours
• This field may default to a value from the employee record. 

Rate From Select the applicable employee data item from the drop-down list. 
• This field may default to a value from the Rate from field on the earnings item. 
• Changes to this field may change the default Amt/Hrs/Units.

Rate Value Select the applicable edit value for the selected Rate From.
• This field may default to a value from the employee record. 
• Changes to this field may change the default Amt/Hrs/Units.
• Rate Value is usually used for classified earnings.
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Costcode Select the applicable costcode from the drop-down list.
• This field may default to a value from the Pay Calculation tab of the employee 

record. 
• This column will not display if you did not set the Costcode option in the Payroll 

Parameter to “Yes” (field 1). 

Dist Table Select the applicable distribution table from the drop-down list.
• This field may default to a value from the employee record. 
• This column will not display if you did not set the Dist Table option in the Payroll 

Parameter to “Yes” (field 1). 

Shift Item Select a shift item from the drop-down list.
• This column will not display if you did not set the Shift emps option in the Payroll 

Parameter to “Yes” (field 1).
• This field will be disabled if the earnings item has been defined for the following 

Entry type (field 4 of earnings item definition): Amount, Dated, Hours, or None.

Shift Value Select a shift item from the drop-down list.
• This column will not display if you did not set the Shift emps option in the Payroll 

Parameter to “Yes” (field 1).
• This field will be disabled if you have not selected a Shift Item.

Rate Override Enter a rate value or select from the drop-down list.

Date Enter a valid date. 
• This field will be enabled if the entry type for the earnings item (field 4) is one of the 

dated entry options. However, the system will not enter a default date.

Error Type This field is reserved to indicate if the system has encountered an account or basis 
error. The field will indicate the type of error. The actual error is elaborated in the 
Basis Detail and/or Account Detail areas in the lower part of the timesheet.

Table 3.1—Timesheet Entry Fields (Continued)

Field Description
Creating a Single Timesheet 
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7. Review the Basis detail (Figure 3.4). You may not be able to modify these 
selections. (If the title text for this area is disabled, you cannot modify any of the 
basis selections.) 

Figure 3.12—Example Basis for Selected Line Area

8. Address any error message that display in the Invalid Basis box.

9. Review the account built by your entries (Figure 3.7). 

Figure 3.13—Example Basis for Selected Line Area

10. If necessary (and allowed by the earnings item definition), you can click  and 
select an existing, active account number. 
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11. Click OK to create this timesheet, or click Cancel to close the timesheet 
without saving your selections.

EDITING A TIMESHEET
Once a timesheet has been created, the system does not differentiate between a 
timesheet created through the group or single timesheet process. Until you post a 
timesheet, you can change or delete any of the timesheet entries (as always, depending 
on your security settings). 

Because of the complexity of the program, you cannot edit certain information 
on a timesheet (e.g., earnings item, employee ID). You must delete the line item 
or the timesheet and enter the correct information.

Use the following instructions to edit a timesheet.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

3. Double-click the employee whose timesheet you want to enter, or select the 
employee and click Edit.

4. Edit the information, as necessary. The status cell will reflect your changes and 
the entry is updated when you click OK (saving your changes) (Figure 3.14). 

Figure 3.14—Modified Timesheet Entry

Because of the complexity of the calculations necessary for each 
earnings item, you cannot change an earnings item selection (e.g., 
change from Hourly to Salary). You must delete the earnings item and 
add a new item.
Editing a Timesheet 
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5. To delete an entry (i.e., line item), click the Status cell for the line and click 
Delete (Figure 3.15). The status changes to Deleted and the entry is removed 
from the timesheet when you click OK (saving your changes). 

Figure 3.15—Deleted Timesheet Entry

6. When complete, click OK to save your changes and close the timesheet 
window.

DELETING A TIMESHEET
Use the following steps to delete a timesheet.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

3. Select the employee and click Delete. A confirmation message displays.

Although you are selecting the employee in this folder, this task only 
removes all current timesheet entries for this employee. It does not 
remove the actual employee record from your database.

4. Click Yes to delete the timesheet or click Cancel to exit this task without 
deleting the timesheet.

VERIFYING TIMESHEETS
When you add a timesheet (i.e., click OK from the timesheet window), the system 
completes a preliminary check for the basis amount and account number. However, each 
timesheet must also pass a more detailed verification process before you can post it to 
the next step. Verifying confirms that:

• The account numbers built by the timesheet process are active for posting.
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• All basis items are valid historical data items.
Unless you select specific employees to verify, this task is performed on all timesheets 
in the Timesheets folder. Once the process is complete, any errors are indicated in the 
Acct Error or Basis Error columns. You must resolve any outstanding errors before you 
can post the timesheet.

The Post task is also performed on all timesheets in the Timesheets folder. 
However, any timesheets with errors will be ignored. In other words, an error on 
one timesheet will not stop you from posting verified timesheets.

Use the following steps to verify timesheets.
1.  Click Open… on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

3. Click Verify. The Verify All Timesheets window displays (Figure 3.16).

Figure 3.16—Verify All Timesheets

4. Select what level of Error Reporting you want to include on the Timesheet 
Verification Report (PYTCARD):

• Report Only Fatal Errors—Report only those employees with one or more 
errors that prevent the timesheet from being verified and posted.
Verifying Timesheets 
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• Report All Timesheets—Report all timesheets, including those with no 
errors. This is the recommended choice; just because valid account and 
basis information exists does not guarantee its accuracy or check for 
missing basis.

• Report Only Fatal and/or Warning Errors—Report only those employees 
with one or more errors that prevent the timesheets from being verified and 
posted, and report warnings, which alert you to possible problems but do 
not prevent a timesheet from being verified and posted. This information 
prints in the Messages column of the Timesheet Verification Report.

See Verification Warnings and Errors on page 2.78 for more information on this 
report.

5. Select the Check for Missing Timesheets check box if you wish to verify that all 
active employees have timesheets. By default, the program will not check for 
missing timesheets.

6. Select the Print Accounting Information check box if you want accounting 
information printed on the report. Not selecting this box will print only account 
errors. This is recommended.

7. Select the Print Basis Information check box (recommended) if you want the 
basis information printed on the report. Not selecting this box will print only the 
errors.

8. Select the Page Break On Change check box if you have chosen to use Sort 
Items and you want a new report page each time the first sort item changes.

9. Click Sort Items if you want to select employee data items to order the 
information in the Timesheet Verification Report. 
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10. Select the employee data item on the left, and click Select to move it to the list 
on the right (Figure 3.17). 

Figure 3.17—Sort Items—Verify Time Cards

Click the Sort Order up or down arrow to move it up or down on the 
list. The list reflects the order in which the data items will appear in the 
report.

11. Click OK to save your settings and close the Sort Items window.

12. Click OK to verify all timesheets in the Timesheets folder. When complete, the 
system returns you to the Timesheets folder. Any errors or problems are 
indicated in the Acct Error and Basis Error columns. 

You are now ready to post any verified timesheets.

VERIFICATION WARNINGS AND ERRORS

Each time you verify timesheets, Payroll generates the Timesheet Verification Report. 
You should print the Timesheet Verification Report to see if there were errors or 
warnings during the verification process. Use the following instructions to view or print 
the report.

1.  Select File > Print Manager from the menu bar.

2. Select PYTCARD and click Open.

3. Click Print  on the toolbar or select File > Print.
Verifying Timesheets 
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TIMESHEET VERIFICATION WARNINGS

The Timesheet Verification Report may include warning messages that inform you of 
possible problems (Table 3.2). However, these problems will not prevent you from 
posting the timesheet. 

TIMESHEET VERIFICATION ERRORS

The Timesheet Verification Report may include error messages that inform you of 
possible problems (Table 3.3). You must correct any errors before you can post the 
timesheet. 

Table 3.2—Message Column Warnings

Timesheet Verification 
Warnings Explanation

Active employee w/ no 
entries.

The Check for Missing Timesheets field was clicked, and an employee 
with no timesheet was found.

Calculated amount is 
zero.

The rate times hours (or units) equals zero, so the Rate item field is zero. 
Go to the employee record to correct the hourly or unit rate of pay. 

Hours exceed day limit. In a 24-hour period, the hours for the employee were over the limit defined 
in the setup parameters.

Hours exceed period limit. In the timesheet period, the hours for the employee were over the limit 
defined in the setup parameters.

Terminated employee. The employee was terminated. Check to see if a check should be issued. 
If not, delete the timesheet.

Terminated employee has 
timesheets.

Review the list of employees.

Table 3.3—Message Column Errors

Timesheet Verification 
Errors Explanation

Account errors Reports the total number of account errors.

Basis errors Reports the total number of basis errors.

Day errors Reports the total number of day errors.

Entry/edit in process Another user is signed on and is adding or editing timesheets. 
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Invalid account - 
change not allowed.

This error occurs when creating a group of timesheets, and means the 
account number is invalid. Check that the Debit Option field of the historical 
data item record (in setup parameters) and the employee’s record are correct. 
You may also edit the Chg acct/basis earnings items field in to allow the 
account to be changed. Then edit the current timesheets, or delete and 
recreate them. 

Invalid account - 
change required.

This error occurs when creating a group of timesheets, and means the 
account number is invalid. Check that the Debit option field of the historical 
data item record and the employee’s record are correct. Then edit the current 
timesheets, or delete and recreate them. 

Invalid basis - change 
not allowed.

This error occurs when creating a group of timesheets. The Basis for field is 
invalid, and the Chg acct/basis field in the historical data item definition does 
not allow the basis to be changed. Check that the Basis for field on the 
historical data item and/or the Addtl basis for field on the employee’s record 
are correct. You may also edit the Chg acct/basis field to allow the basis to be 
changed. Then change the current timesheets, or delete and recreate them.

Invalid basis - change 
required.

This error occurs when creating a group of timesheets. The Basis for field is 
invalid. Check that the Basis for field on the historical data item and/or the 
Addtl basis for field in the employee’s record are correct. Then change the 
current timesheets, or delete and recreate them. 

No “out” for this “in”. An “out” is missing for a clocked “in”.

No “in” for this “out”. The first clocked timesheet is an “out” or there are two “outs” in a row.

Period errors Reports the total number of period errors.

Posting in process. Another user is posting timesheets. You cannot enter or verify additional 
timesheets until the posting completes.

Rate lookup must be 
numeric.

None of the lookup columns on the employee data item entered in the Rate 
Value field is defined as a numeric field. One of the Lookup columns must be 
defined as a whole number, #, an amount, $, a rate, or R.

Rate missing for 
employee.

This occurs when adding a single timesheet. The employee data item entered 
in the Rate Item field does not exist on the employee’s record. Check that the 
employee should receive this earning type. If so, add the earning rate to the 
appropriate earning category on his timesheet. If the timesheet should not 
have been entered, delete it.

Rate must be 
numeric.

The employee data item entered in the Rate Item field must be defined as a 
numeric field. It must be a whole number, an amount, or a rate.

Table 3.3—Message Column Errors (Continued)

Timesheet Verification 
Errors Explanation
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To fix errors in an employee’s record, select the desired employee in the Employees or 
Timesheets folder, and double-click or click Edit. After making and saving the 
necessary corrections to the employee’s record, verify the timesheets again and check 
that your correction fixed the error.

POSTING TIMESHEETS
Once you have verified your timesheets, you are ready to post the timesheets to the next 
step in the process. The posting task involves the following:

• Preparing timesheets for net pay calculation and check processing. (You must 
post timesheets to the Net Pay Calculation folder before you can process 
checks.)

• Posting the information to General Ledger using the Labor Journal defined in 
the Payroll Parameter (field 4). (The normal journal entry is a debit to wage 
expense, and a credit to accrued payroll account defined in the Payroll 
Parameter.)

Unless you select specific employees to verify, this task is performed on all timesheets 
in the Timesheets folder. Once the process is complete, the timesheets move to the Net 
Pay Calculations folder. Use the following steps to post timesheets.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Timesheets folder. All unposted timesheets display in the detail pane.

Shift lookup must be 
numeric.

None of the lookup columns on the employee data item entered in the Shift val 
field is defined as a numeric field. One of the columns must be defined as a 
whole number, #, an amount, $, a rate, or R.

Verification in process. Another user is already running Verify Timesheets. If you want to run verify 
again, wait until the first user is finished.

Warning - Timesheets 
cannot be posted.

There are errors in timesheet account, basis, rate, or shift. Review the 
message column of the report to find specific employees with errors. Make 
corrections, verify timesheets again, and print another Timesheet Verification 
Report. Repeat all these steps until all timesheets are verified.

Table 3.3—Message Column Errors (Continued)

Timesheet Verification 
Errors Explanation
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3. Click Post. The Post Timesheets window displays (Figure 3.18).

Figure 3.18—Post Timesheets

Because this feature is not applicable in the current version of the 
software, the Check Sequence text box should be disabled. If it is not, 
please ignore this field.

4. Use the Employee Selector to post timesheets for a select group of employees. 
(By default, the system will post all verified timesheets in the folder.) 

5. Click OK. The Post All Timesheets window closes and you return to the 
Timesheets folder. The verified timesheets are posted to the Net Pay 
Calculations folder and no longer appear in the Timesheets folder.

After timesheets are posted, they are ready to be calculated. Calculating Net Pay is 
covered in Chapter 4—Calculating Net Pay on page 2.83.
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CALCULATING NET PAY

Before you can produce checks for your timesheets, you must calculate and subtract any 
applicable deductions from the timesheet total (i.e., calculate net pay). These deductions 
can include standard deductions (e.g., deduction for insurance) or one-time deductions 
(e.g., correction to tax deduction). 
Once you complete your net pay calculations, you are ready to produce your checks and 
direct deposit files, which you will also do from the Net Pay Calculations folder. 

WHAT ARE ONE-TIME DEDUCTIONS?
The one-time deduction task allows you to enter a deduction manually. (When you 
calculate net pay, you can select deductions based on the calc period.) One-time 
deductions are items that are not normally part of an employee’s paycheck. They can 
include:

• Deductions for an advance,
• Deductions for a one-time wage garnishment, and
• Adjustments or corrections to the amount of a tax or other deduction.

This task uses data items that have been defined as History type—D (Deductions) or T 
(Taxes) in field 1 of the historical data item record. (See Defining Historical Data Items 
on page 1.85 for more information on this definition.) 

ENTERING ONE-TIME DEDUCTIONS
Use the following steps to enter one-time deductions.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.
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2. Select the Net Pay Calculations folder. All timesheets at this stage of the 
payroll process display in the detail pane. 

3. Click One-Time Deductions. (You can also select the timesheet, right-click, 
and select Enter One-Time Deduction from the shortcut menu.) The One-
Time Deductions window displays (Figure 4.1). 

Figure 4.1—One-Time Deductions

4. Select the applicable deduction or tax type from the Data Item drop-down list.

5. Enter the amount to be deducted from the employee’s check in the Amount text 
box. (This field is required; you cannot leave it blank.) Remember:

• A positive number decreases the check amount.
• A negative number increases it.

6. Enter the number of hours on which this deduction or tax is based in the Basis 
Hours text box. (If this field does not apply to this deduction, leave it blank.)

7. Enter the amount on which this deduction or tax is based in the Basis Amount 
text box. (If this field does not apply to this deduction, leave it blank.)

.FICA is based on the dollar amount of total earnings. Your 
organization uses basis amounts in production of year-end tax forms; 
therefore, this information must be entered correctly. However, the 
basis amount was entered incorrectly in the employee’s history. 
Therefore, you add a correcting entry using the one-time deduction 
task. In the Basis Amount field, you enter the dollar amount (i.e., 
wages) on which the correction is based.

8. Click OK. Payroll processes the one-time deduction and closes the One-Time 
Deduction window.
Entering One-Time Deductions 



Chapter 4—Calculating Net Pay
You can view the timesheet information, including one-time deductions by selecting the 
timesheet and clicking Detail. (You can also double-click the timesheet, or right-click 
and select Detail from the shortcut menu.)
You can also check the results of your work by printing and reviewing the Preliminary 
Check Register (created during the check writing process), or by producing the 
Calculation Trace report (PYCTNE.L##). (See Producing the Calculation Trace Report 
on page 2.89 for instructions to produce this report.) 

Because a one-time deduction could impact your taxable income (which is 
usually part of the net pay calculation), you should complete any one-time 
deductions before calculating net pay. If you calculate net pay and then add a 
one-time deduction, you must re-calculate net pay (see Calculating Net Pay on 
page 2.86).

CORRECTING ONE-TIME DEDUCTIONS

To correct a one-time deduction entry before checks are produced, enter an adjusting 
one-time deduction entry. For example, you enter a one-time deduction for health 
insurance for $50.00. After reviewing your Preliminary Check Register, you realize the 
deduction should be for $60.00. To correct this, enter another one-time deduction entry 
for $10.00. 

WHAT ARE NET PAY CALCULATIONS?
The net pay calculation task allows you to enter one or more deductions based on the 
calc period defined for the deduction. 
Net pay calculation uses data items that have been defined as History type—D 
(Deductions) or T (Taxes) in field 3 of the historical data item record. (See Defining 
Historical Data Items on page 1.85 for more information on this definition.) 
Additionally, when you defined the data item, you had the option of indicating that the 
calculation is never used, always used, or assigned to one of nine calculation cycles 
(field 3). When you calculate net pay, the data items are grouped by cycle and you can 
apply one or more cycles to the selected timesheets. (Data items that are always used are 
assigned to all cycles.)

A typical use of calculation cycles is for deductions that occur every other pay 
period or employer-paid benefits that are only calculated annually. 
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You may calculate net pay as many times as necessary until the payroll is correct. When 
you rerun this task, it replaces the previously-calculated paycheck with the new 
information.

Because a one-time deduction could impact your taxable income (which is 
usually part of the net pay calculation), you should complete any one-time 
deductions before calculating net pay. If you calculate net pay and then add a 
one-time deduction, you must re-calculate net pay.

CALCULATING NET PAY
Unless you select specific employees to verify, this task is performed on all timesheets 
in the Net Pay Calculations folder. Once the process is complete, you will be ready to 
write checks for any timesheets that calculated correctly (any errors are indicated in the 
Status column). 
Use the following steps to calculate net pay for some or all timesheets in the Net Pay 
Calculations folder.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display. 

2. Select the Net Pay Calculations folder. All timesheets at this stage of the 
payroll process display in the detail pane. 

3. Click Calculate Net Pay. (You can also select the timesheet, right-click, and 
select Calculate Net Pay from the pop-up menu.) The Calculate Net Pay 
window displays short description of the historical data items defined with a 
calculation cycle (field 4). The HDIs are organized by those cycles (Figure 4.2). 

Figure 4.2—Example Calculate Net Pay

In Division 95, we have only 
two cycles. Each cycle has four 
HDIs assigned to it. (Most of 
our HDIs are not assigned to 
specific cycles.)
Calculating Net Pay 
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4. Click Employee Selector to calculate net pay for a specific group of employees 
(i.e., a subset of the employees with posted timesheets). The Employee Selector 
displays (Figure 4.3). 

Figure 4.3—Employee Selector

5. Enter your selection parameters. (For more instructions on the Employee 
Selector, see Using the Employee Selector on page 2.52.)

6. When you have completed your selection, click OK. The Employee Selector 
closes and you return to the Calculate Net Pay detail pane.

7. Select one or more check boxes for the calculation cycles that you wish to 
calculate. 

If you defined your Payroll parameter to allow multiple checks (field 
2), a Check Sequence field may display. However, this feature is not 
supported in the current version of the software and the field must be 
ignored.
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8. Click Calculate. When the program has completed the calculation process, the 
Calculate Net Pay window closes and you return to the Net Pay Calculations 
folder. The calculation status of the timesheets displays in the Status column 
(e.g., Calculated, Calc. Error - Account). 

VIEWING CALCULATION INFORMATION
You can view the timesheet information, including one-time deductions by selecting the 
timesheet and clicking Detail (Figure 4.4). (You can also double-click the timesheet, or 
right-click and select Detail from the shortcut menu.) 

Figure 4.4—Display Calculation Results

You can view the timesheet information in greater detail in a number of ways:
• Calculation error report (PYCTNE.L#)—The details of any calculation errors 

are written to this report. 
— This is the same file name given to the Calculation Trace report, which 

shows the results of each line of a calculation for a single data item for a 
single employee. 

• The Calculation Trace report (PYCTNE.L##)—See Producing the Calculation 
Trace Report on page 2.89 for instructions.

• Preliminary Check Register—The system creates this report during the check 
writing process. See Writing Checks Using the Wizard on page 2.97.

• Distribution After Net Pay Calculations report—A sorted distribution report in 
account dimension(s) order after net calculations and before check production. 
See Producing the Distribution After Net Calculations Report on page 2.152.
Viewing Calculation Information 
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PRODUCING THE CALCULATION TRACE REPORT
The Calculation Trace report (PYCTNE.L##) shows the results of each line of a 
calculation (one-time or net pay) for a single data item for a single employee. (You can 
only run this report for one employee at a time.) However, you can only produce the 
Calculation Trace report when you have a calculated net pay but not yet produced your 
checks (i.e., the Status column displays “Calculated” or “Calc Error”).

This report is a very useful tool for troubleshooting payroll calculation issues (e.g., 
checking a new calculation, investigating a calculation result that seems incorrect). Use 
the following steps to produce the Calculation Trace report.

1.  Click Processing > Check Processing > Calculation Trace Report on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Check Processing > Calculation 
Trace Report from the menu bar. The first page of the Calculation Trace report 
parameters window displays (Figure 4.5). 

Figure 4.5—Calculation Trace Report—Page 1 of 2

2. Enter the applicable calculation cycle number (or numbers) separated by a space 
or comma and press ENTER. If you used one or more calculation cycles when 
you calculated net pay, you must enter the calculation number (or numbers) in 
this field.
Blackbaud, Inc. 2.89



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.90
3. Enter the applicable data item name and press ENTER. (You can access a list of 
data items by pressing F1.) The Items Selection field displays (Figure 4.6). 

Figure 4.6—Calculation Trace Report—Item Selection

4. Enter the order number for the item selection and press ENTER. (This number 
simply helps you organize your entries, it is not used in the report.) 

5. Enter an employee data item (should be .EMPLOYEE to filter by employee 
number, or you can use the employee name to produce the report for one 
employee). The second page of the Calculation Trace report parameters window 
displays (Figure 4.7). 

Figure 4.7—Calculation Trace Report—Page 2 of 2
Producing the Calculation Trace Report 
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6. Enter the first and last values to filter the information in the report, and indicate 
if these records are included or excluded.

7. When complete, press ESC to display the option menu.

8. Type E to end the session 

9. Type 0 to accept your entries.

10. Press ENTER to file a report (accepting the Yes option). The report 
(PYCTNE.L##, where ## represents your division number) is created and saved 
to your Reports folder.

11. Access the report through Print Manager.
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The report consists of the calculation definition (maintained in field 8 of the HDI 
definition) (Figure 4.8) and the line-by-line calculation for the employee (Figure 4.9). 

Figure 4.8—Example Calculation Trace Report—Page 1
Producing the Calculation Trace Report 
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Figure 4.9—Example Calculation Trace Report—Page 2

CORRECTING NEGATIVE CALCULATIONS
A negative check amount (i.e., the sum of the earnings is less than the sum of the taxes 
and deductions) will display in the detail pane and the timesheet detail window in red 
type within parenthesis. A negative net pay can be caused by:

• An incorrect calculation formula;
• Incorrect data items on the employee record;
• Low earnings, which cause the taxes and deductions to be higher than the wage; 

or

The system 
registers display 
at the start of the 
calculation.

The body of the 
report presents the 
calculations results, 
line by line.

The amounts in registers 3 and 4 
come from:

• Earnings items that are 
defined with this data item in 
the basis for field (field 4),

• Additional basis defined on the 
employee record, or

• Distribution tables.
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• A one-time deduction that is higher than the wage.
You can correct this situation by editing the employee record, the one-time deductions, 
or the calculation formulas. 

ENTERING AN OFFSETTING TIMESHEET

To correct a calculated negative amount, you must create an offsetting, positive 
timesheet for this employee.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Employees or Timesheets folder. All timesheets at this stage of the 
payroll process display in the detail pane. 

3. Click Single. The Create/Edit Single Timesheet window displays.

4. Select the correct earnings item for this employee (e.g., Salary, Hourly) and 
create a timesheet for a positive amount that will offset the negative amount. 
This will reverse the journal entry.

5. Verify the timesheet to check for basis or account errors.

6. Post the timesheet to the Net Pay Calculations folder.

7. Recalculate the net pay. You may recalculate for all employees or use the 
Employee Selector to choose only the employee with the negative timesheet 
amount. 

If the offsetting entry exactly matches the negative amount, this employee will disappear 
from the list in the Net Pay Calculations folder.

PROCESSING NEGATIVE CHECKS

While you may wish to process a negative direct deposit (to correct an error), there is 
little reason to produce a negative check. Payroll/Personnel warns that you have a 
calculated amount that is negative, and prompts you to:

• Use the Employee Selector to skip this check,
• Correct the error, or 
Correcting Negative Calculations 
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• Fix the negative amount (Figure 4.10). 

Figure 4.10—Negative Checks Message

If you do not correct the negative amount before you get to the Log Check Numbers 
window of the Check Writing Wizard (Figure 4.11), you will produce, print, and log a 
negative check. The Bank Accounts folder will reflect the negative amount, and you 
will then need to void the negative check. 

Figure 4.11—Example Negative Check
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PRODUCING CHECKS

After you’ve calculated net pay for your timesheets, you are ready to produce your 
checks. You can create one or more checks using the Check Writing Wizard or you can 
create a single manual check for each timesheet. 

• The Check Writing Wizard guides you through producing and printing checks, 
while also creating a Preliminary Check Register, defining information needed 
for banking, and logging the checks. 

• A manual check is one written outside of FundWare. You must manually enter 
all the required check information for each check to maintain correct employee 
history, including amounts for all historical data items that are normally 
calculated by Payroll/Personnel. 
— Because you must manually enter all this information, we strongly 

recommend that you avoid writing manual checks.
With either method of creating checks, your expenses are posted to General Ledger on 
the business date used when the task is selected. Checks are written for the Check date 
entered for the check.

WRITING CHECKS USING THE WIZARD
Use the following steps to write one or more checks/direct deposits using the wizard.

1.  Click Open… on the module navigator (if the module is not expanded, click 
Payroll/Personnel first) or select Payroll/Personnel > Open… from the menu 
bar. The Payroll/Personnel folder tree and detail pane display.

2. Select the Net Pay Calculations folder. All timesheets at this stage of the 
payroll process display in the detail pane. 
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3. Click Check Writing. (You can also right-click in the detail pane and select 
Post to Check Writing from the shortcut menu.) The Check Writing Wizard 
displays, open to the Getting Started window (Figure 5.1). 

Figure 5.1—Payroll Check Writing Wizard, Getting Started

4. Select the bank (i.e., Financial Institution account) for this check run (for both 
checks and direct deposits) from the Bank drop-down menu. The Starting Check 
Number field is automatically filled with the next applicable number, based on 
the Financial Institution account definition.

After selecting the appropriate bank, a confirmation message may display 
(Figure 5.2). If this message does not display, move to step 6 on page 2.98. 

Figure 5.2—Delete Old Check File Message

5. Click Yes or No, depending on whether or not you want to delete the check file. 

6. If you are creating an EFT file (i.e., direct deposit file), select one or more 
Direct Deposit Cycles. (These cycles correspond to the cycle setting on the 
Direct Deposit tab of the employee record.)

In this example, PYCK is 
the file name, 1 is the 
bank ID, and l95 is the 
division.
Writing Checks Using the Wizard 
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If you are not creating an EFT file (i.e., you are creating physical 
checks), leave these check boxes blank.

7. Enter a valid date in the Check Dates text box. For checks, this date will appear 
on the printed checks. For direct deposit payments and files, this date will be 
applied to the transactions.

By default, the current business date is entered in this field. You can 
change this date, as necessary; the check date does not need to match 
the business date.

8. If the Starting Check Number field is editable (i.e., not disabled), you can 
change the starting check number, if necessary.

If you selected the Auto Number Checks check box of the FIA 
definition, you cannot edit this field. The system will automatically 
update the Starting Check Number each time you run the Check Writing 
wizard. (For more information on FIAs, see Chapter 4—Using the 
Financial Institutions Feature on page 1.131.)

9. Click Next to proceed to the Define Preliminary Check Register window 
(Figure 5.3). 

Figure 5.3—Payroll Define Preliminary Check Register
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You must create the Preliminary Check Register to produce checks and 
direct deposit payments. The Preliminary Check Register allows you to 
review the result of the net pay calculation and a preview of the actual 
check register. The fields that you complete here determine the amount 
of detail included in the Preliminary Check Register.

10. Select the Detail Register check box to include a detail register for data items. 
The historical data item definition determines which data items will get a detail 
register.

11. Select the Account Info check box to include account numbers. If you do not 
select this check box, you will get year-to-date information.

12. Select the Basis Info check box to include the basis for information from the 
timesheets. If you do not select this check box, you will get year-to-date 
information.

13. Click Sort Items to choose employee data items to order the information in the 
Preliminary Check Register (e.g., produce checks by city, departments, earnings 
type) (Figure 5.4). If you do not want to define a sort order, move to step 17. 

Figure 5.4—Sort Items—Preliminary Check Register

14. Select the employee data item on the left and click Select to move it to the list 
on the right. 

15. Click the Sort Order up or down arrow to move it up or down on the list. The list 
reflects the order in which the data items will appear in the preliminary check 
register.

16. Click OK to save this sort order and return to the Check Writing wizard.
Writing Checks Using the Wizard 
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17. Click Employee Selector to produce a Preliminary Check Register for a select 
group of employees. If you do not want to define a sort order, Payroll will create 
checks in employee number order for all employees listed in the Net Pay 
Calculations folder and move you to the next step.

18. Click Next to produce the Preliminary Check Register. The Preliminary Check 
Register shows the result of the net pay calculation and a preview of the actual 
check register (Figure 5.5). 

Figure 5.5—Preliminary Check Register

Each time the Preliminary Check Register is produced, it replaces the 
previous one.

To view the entire Register, press PGDN or scroll down.

We recommend that you print and review the Preliminary Check 
Register at this time.

19. Click Print Preliminary Check Register to produce the check register and 
view in Print Manager. Print Manager opens.

20. Through Print Manager, select the PYPREG.L## report and click Open.

21. Select File > Print to print this report.
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22. Review the Preliminary Check Register. If it is incorrect, you may need to 
cancel out of this task and make corrections on the employee record, at the 
timesheet step, or at the net pay calculations step. Once your corrections are 
entered, you must restart the check wizard.

23. Once the Preliminary Check Register is correct, click Next to produce and print 
checks (Figure 5.6). The Produce Checks window displays. 

Figure 5.6—Produce Checks

24. Verify that the check date is correct. If it is not, click Back to return to the 
Getting Started window and enter the correct date.

25. If your system is configured to produce the timesheet history stub, enter a date 
range, based on the business date when you posted the timesheets, for the 
information included in the stub.

To use this feature, certain fields in the Payroll parameter and check 
format must be defined with specific settings. For more information, 
see Using the Timesheet History Stub Feature on page 1.177.
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26. Click Next to produce the checks. The Log Check Numbers task displays 
(Figure 5.7). 

Figure 5.7—Log Check Numbers

Because of printer problems, it is not always possible to use the check 
numbers in sequence; therefore, you should always print your checks 
before logging the check numbers.

27. Open Print Manager and produce your checks from the PYCK (checks) and/or 
PYSTUB (direct deposit) files.

28. If you are doing direct deposit, transmit the appropriate file to the employee’s 
bank (or banks):

• ##PY2 in your Data folder if you answered T or U in the File format field in 
the direct deposit parameter record, or

• ##PYN file in the Data folder.
The report name will include the use ID number of the FIA, as well as 
the division number. For example, Cranberry National Bank in Division 
95 has a use ID number of 1. Therefore, all check files are named 
PYCK1.L95.

Once you print your checks, you are ready to return to the Check Writing Wizard and 
log the check numbers.

If the FIA is defined to autonumber the checks or if the check run is all direct 
deposits, you will not be allowed to log different check numbers. In this case, 
you are ready to click Finish to complete the check writing process. 
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LOGGING YOUR CHECK NUMBERS

After you successfully print your checks, you must log the physical check numbers on 
the Log Check Numbers window of the Payroll Check Writing Wizard. If you have 
closed the wizard, you will return to this window when you click Check Writing (from 
the Net Pay Calculations folder) and select the FIA. 
However, if the FIA is defined to autonumber the checks or if the check run is all direct 
deposits, you will not be allowed to log different check numbers. In this case, you are 
ready to click Finish to complete the check writing process.

You will not be able to calculate net pay for additional timesheets until you 
complete the check writing process for these timesheets by logging your check 
numbers. 

Use the following instructions to log your check numbers.
1.  Select the check or checks to be numbered using your mouse (you can select 

consecutive checks using SHIFT), or enter a range of checks using the check 
sequence number (Figure 5.8). 

Figure 5.8—Using Sequence Numbers to Assign Check Numbers

If you use your mouse to select checks, the From and To sequence 
numbers will reflect your selection. Manually changing the sequence 
numbers will change the checks selected for numbering.

Sequence numbers are system-generated numbers that allow you to 
track the checks before physical check numbers have been assigned.

2. Enter the first (or only) check number in the Start Chk # field. This number is 
the actual printed check number for the first highlighted check; the system will 
number all other highlighted checks sequentially from this number.

If your check run is all direct deposit, the system will disable the From, 
To, and Start Chk # fields.

3. Click Assign. The system assigns the check numbers and displays the numbers 
in the Check column. 
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4. Continue this process until all checks are numbered (Figure 5.9). 

Figure 5.9—Example of Non-Sequential Check Numbers

5. In the Select Final Register Detail area (Figure 5.10), select the applicable 
check boxes to include account and/or basis information in the final register. 

Figure 5.10—Select Final Register Detail Area
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6. Click Sort Items. The Sort Items window displays (Figure 5.11). 

Figure 5.11—Sort Items Window

7. Select the data items on which the checks will be sorted in the PYREG.L## file. 
Use the up and down arrows to prioritize the sort items.

8. Click OK. You return to the Log Check Numbers window.

9. Click Finish to log the checks and exit the Check Writing Wizard. The software 
posts the Direct Deposit payments and/or logged checks to the General Ledger 
according to the business date and updates and posts to the Payroll/Personnel 
module according to the date in the Check Date field.

If the check date is different from the current business date, Payroll 
produces two trace reports.

When the process is complete, a message displays indicating that the 
information has posted to Financial Institutions (produces BRPOST.L##).

10. Click OK.

We strongly recommend that you review the trace report(s).

11. As a final check, you may want to review the final Check Register 
(PYREG.L##) and compare the information with the Preliminary Check 
Register.
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PRODUCING A DIRECT DEPOSIT PROOF LIST

After producing the checks and Direct Deposits, you may wish to review the Direct 
Deposit transactions that will be transmitted to the bank. Print and file the Direct 
Deposit Proof List along with your check registers.
Use the following steps to Produce a Direct Deposit Proof List.

1.  Click Processing > Check Processing > Produce EFT Proof List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Processing > Check Processing > Produce 
EFT Proof List from the menu bar. A confirmation message displays.

2. Enter Yes to produce this report. A second confirmation message displays.

3. Enter Yes to file this report. The system produces the report and closes the 
window.

4. Through Print Manager, access the PYLPEFT.L## report. 

ENTERING A MANUAL CHECK
A manual check is one written outside of the Payroll/Personnel software. You must then 
enter all the required check information to maintain correct employee history, including 
employer cost items as well as earnings, taxes, deductions, basis amounts, hours, and all 
account numbers. 

Because of the complexity and effort of entering all this information, we 
strongly recommend that you do not create manual checks. Let the program 
calculate and produce all checks, even if the check run consists of a single 
check.

When entering a manual check, you will be prompted for a batch total (the net total of 
the checks) for the check. Once you have entered the entire transaction, the Balance to 
go amount should be zero. If not, a net amount may be incorrect or missing, or the batch 
total may be incorrect. Once you have posted the manual check, the program:

• Posts expenses to General Ledger on the business date used when the task is 
selected. 

• Posts checks on the Check date entered for the check. 
• Files a manual check register and one or more trace reports (i.e., two trace 

reports are created when the business date is different than the check date).
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Use the following steps to enter a manual check.
1.  Click Transaction Entry > Enter Manual Checks on the module navigator (if 

the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Transaction Entry > Enter Manual Checks from the menu bar. 
The system asks you to enter the batch total (i.e., the net total of the check) for 
the check (Figure 5.12). 

Figure 5.12—Enter the Batch Total

2. Enter the net total of check that you wish to process. You may leave this field 
blank by pressing ENTER. Let the system calculate the total, and enter it before 
posting the batch.
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3. Press ENTER. As you complete each of the required fields on page 1, the next 
field is revealed (Figure 5.13).

Figure 5.13—Entering Manual Checks, Page 1 of 3

4. Complete the fields on the first page of the task according to Table 5.1. 

Table 5.1—Manual Check Field Definitions

Field Valid Entry Definition

Batch total $—amount or 
<blank>

The net total of all manual checks to be entered. You may leave 
this field blank by pressing ENTER. Let the system calculate the 
total, and enter it before posting the batch

Bank 1–10 characters The Use ID for the Financial Institutions account for which the 
manual check was written.
• Press F1 for a list of Financial Institutions accounts associated 

with Payroll/Personnel.

Check 
number

#—number The check number for which the manual check was written.

Run System generated The system-assigned run number is displayed.

Check date 99/99/9999 The date on which the check was written.

Employee #—number The number of the employee who received the manual check.

Net amount $—amount The net amount of the manual check.
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5. Press ENTER to move to the second page of the task (Figure 5.14). You will enter 
that data items associated with this check on this page. 

Figure 5.14—Entering Manual Checks, Page 2 of 3

6. As you enter the data items for this check, the Entry number will track which 
item you are entering. You can change this number, as necessary.

7. Press ENTER to begin working on the data item. The fields associated with the 
data item display (Figure 5.15). 

Figure 5.15—Entering Manual Checks, Page 2 of 3 (Data Item)

8. Enter the applicable data item. (You can select from a list of data items by 
pressing F1.)
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9. Complete the Hours/units, Amount, Basis hrs/units, and Basis amount fields, as 
necessary. 

10. When complete, press ENTER. The third page of the task displays, allowing you 
to enter account information for the data item (Figure 5.16). 

Figure 5.16—Entering Manual Checks, Page 3 of 3 (Account Number)

11. Enter the account number for funds applied to this data item and press ENTER. 
(You cannot enter an account mask, and the system does not build an account 
number automatically.)

12. Enter Db or Cr to indicate if this transaction is a debit or credit (Figure 5.17). 

Figure 5.17—Entering Manual Checks, Page 3 of 3 (Debit or Credit)

For data items that can post both debits and credits, such as employer 
paid benefits, indicate whether the amount entered is a debit or credit. 
Both the debit and credit entries must be made.

13. Press ENTER. The system asks if your entry is correct.

14. Type 0 and press ENTER to accept your entries. The system returns focus to the 
Entry field (on the second page of the task) and increases the Entry number.
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15. Continue entering data items, as necessary.

16. When complete, press ESC to display the option menu and type E to exit the task 
and close the window.

17. Enter P to post the manual check. 

A Manual Check Register is automatically filed using the file name PYMREG.L##, 
where ## is the division number. A separate trace report is produced and filed for each 
date for which posting was done; the name is CDS######.L##. A reconciliation trace 
report with the name BRPOST.L## is also filed.

LOGGING UNUSED CHECKS
When you print your checks, you might lose forms because the printer jams or you 
might waste forms at the beginning or end of the printing job. When this happens, you 
should update the bank reconciliation files by logging the check numbers as “unused.” 

An unused or destroyed check is one that was never issued and never will be 
issued. If the check was actually signed and given to the employee and later you 
must reverse the transaction, you should void the check (Voiding a Check on 
page 2.114).

Use the following steps to log one or more unused checks.
1.  Click Bank Reconciliation > Enter Unused Payroll Checks on the module 

navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Bank Reconciliation > Enter Unused Payroll 
Checks from the menu bar. The option menu displays.
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2. Enter A to log unused checks. The system asks you to identify the bank for 
associated with this task (Figure 5.18). 

Figure 5.18—Enter Unused Payroll Checks—Bank

3. In the Bank field, enter the Use ID for the Financial Institutions account and 
press ENTER. (Press F1 for a list of Financial Institutions accounts associated 
with Payroll.) The remaining fields of the task display (Figure 5.19). 

Figure 5.19—Enter Unused Payroll Checks
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4. Complete the required fields according to Table 5.2. 

5. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system logs the check and returns to the Bank field to allow 
you to log additional unused checks.

6. When you have enter all unused checks, press ESC to display the option menu.

7. Type E to end the task. The system asks if you want to post the information to 
the Bank Reconciliation files.

8. Enter Y to post your unused checks and close this window.

Payroll logs the unused checks and files a reconciliation trace report (BRPOST.L##). 
You can also review unused checks using the Check Reports task.

VOIDING A CHECK
When you void a check, FundWare reverses the Payroll entries and posts reversal entries 
to General Ledger and Accounts Payable (if applicable). You can only void outstanding 
checks and outstanding direct deposits (i.e., once reconciled, you cannot void a 
transaction). When voiding a check, the system uses:

• The business date to post the General Ledger and Accounts Payable entries due 
to the impact on W-2s, and

• The original check date to post the Payroll information.
If you void a payroll check and reissue the check in another payroll reporting 
period, quarter, or calendar year, you may need to amend your 941 reports, W-
2s, and any other payroll reports.

Table 5.2—Log Unused Checks Field Definitions

Field Definition

Check Date Enter the date the checks were produced. The date defaults to the business date 
displayed in the upper right corner of your screen.

Check number Enter the number of the check number you did not use. You can only enter one 
check at a time.

Description Enter a brief description that explains why you could not use the check.
• For example, “Jammed in printer.”
Voiding a Check 
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Use the following instructions to void a check.
1.  Click Open on the module navigator (if the module is not expanded, click 

Payroll/Personnel first) or select Payroll/Personnel > Open from the menu 
bar.

2. Click the applicable FIA folder. 

3. Select one or more check boxes for the check status and click Go to display 
your checks (Figure 5.20). 

Figure 5.20—Example Filter Settings

4. Select the check or checks to be voided. 

Select multiple sequential checks by selecting the first check, pressing 
SHIFT and selecting the last check in the sequence. Select multiple non-
sequential checks by selecting the first check, pressing CTRL, and 
selecting the additional checks.
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5. Click Void. The Void Checks window displays, including the check(s) that you 
selected (Figure 5.21). 

Figure 5.21—Void Checks

If you have multiple items here, you may click on any column header to 
sort them. 

6. Click OK to void these items. (Clicking Cancel will stop the void task and 
return you to the FIA folder.) Once Payroll completed the task, a confirmation 
message displays.

7. Click OK. You return to the FIA folder and the checks or direct deposit entries 
not longer display.

Voided checks must be reconciled when you complete the 
reconciliation process. 

After voiding a check, use Print Manager to review the following reports:
• Void Check Register Report (PYVREG.L##)—occurs automatically
• Bank Reconciliation Posting Report (BRPOST.L##)—occurs automatically.
• GL/AP Journal Entry Trace Report (CS######.L##)—occurs if you are posting 

to the GL.
 

VOIDING AN EFT
Use the following instructions to void a direct deposit.
Voiding an EFT 
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1.  Open an instance of FundWare.

2. From the Division Selection window, select System Administration. (System 
Administration tasks can apply to multiple divisions. Therefore, instead of 
selecting a single division you must select System Administration.)

3. Click System Utilities on the module navigator or select System Administration 
> System Utilities from the menu bar. The System Utilities window displays 
(Figure 5.22).

Figure 5.22—System Utilities Window

4. In the Execute Program area, enter the required information according to Table 
5.3 to run the override.

Table 5.3—Voiding a Direct Deposit

Field Entry

Program Name PYL250

Switches 1

Parameters Leave blank
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5. Click Run. The program displays, asking you to enter the total EFT amount that 
you want to void

Figure 5.23—Entering the Batch Total

6. Enter the total net pay amount that you want to void. (You can adjust this 
amount prior to posting, as necessary.)

7. Press ENTER. The system asks you to identify the bank received these funds 
(Figure 5.24).

Business Date Enter the business date that you want to use for the 
voiding transaction.

Division Select the applicable division from the drop-down list.

Table 5.3—Voiding a Direct Deposit

Field Entry
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Figure 5.24—Entering the Applicable Bank

8. Enter the bank number or press F1 to select from a list of your banks.

9. Press ENTER. The system asks you to enter the check number (Figure 5.25).

Figure 5.25—Check Number Field

10. ENTER 0 or press F1 to view all check and EFT entries. (There is no applicable 
“check number” for EFTs; therefore, you must select the EFT entry from the F1 
list.)

11. Select the applicable EFT entry (Figure 5.26).
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Figure 5.26—Selecting the EFT Entry to Void (Check Number)

When you return to the screen, the field will still show a check number of 0.
12. Press ENTER. The system asks you to enter or select the system number of the 

EFT to void (Figure 5.27).

Figure 5.27—System Number Field

13. Enter the system number or press F1 to select the EFT entry (Figure 5.28).
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Figure 5.28—Selecting the EFT Entry to Void (System Number)

14. Press ENTER. The system retrieves the information associated with the selected 
EFT and asks if your entries are correct (Figure 5.29).

Figure 5.29—Confirmation Message

15. Press ENTER (or type Y) to accept your entries and void this EFT. The system 
indicates that the check has been added to the batch (Figure 5.30).
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Figure 5.30—EFT Added to Batch to Be Voided

16. Continue entering any other EFTs to be voided.

If you have completed your entries and there is still a Balance to go (i.e., you 
entered an incorrect Batch total), type B and correct the total.

17. When you have completed your entries, press ESC to display the session menu.

18. Type E to end the session. The batch option menu displays.

19. Type P to post your entries and void the selected EFTs.

20. Print, review, and save the void check register report (PYVREG.L##) and your 
trace reports.
Voiding an EFT 
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RECONCILING CHECKS

There are several steps involved in the Bank Reconciliation process: 
• Entering a reconciliation—Checks and Direct Deposits are “marked for 

reconciliation,” in preparation for reconciliation.
• Posting a reconciliation—Changes “marked for reconciliation” items to 

“reconciled” using the current business date.
• Purging a reconciliation—Transactions that are “posted for reconciliation” are 

removed from the payroll reconciliation data files.
• Voiding a check—Void checks that have been logged but not reconciled.
• Logging unused checks—Enter unused checks.
• Producing check reports—Choose selection criteria and generate a report with 

the checks in the system (e.g., outstanding checks).
• Displaying your checks—Display reconcilable items on an include/exclude 

basis.
Another step that you may take when reconciling your checks is to import reconciliation 
information. During this task, you import a text file and change the record of your 
“outstanding” checks to “marked for reconciliation.” For more information on 
importing reconciliation files, see the Blackbaud FundWare System Administration 
Guide.

ENTERING A RECONCILIATION
When you are entering a reconciliation, you can work with individual checks or a range 
of checks to:

• Mark for reconciliation,
• “Unmark” for reconciliation (i.e., change from included in the reconciliation to 

exclude from the reconciliation), or
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• Display bank and transaction information.
Use the following steps to begin the reconciliation process.

1.  Click Bank Reconciliation > Enter Reconciliation on the module navigator (if 
the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Enter Reconciliation from the menu bar. 
The Enter Reconciliation window displays (Figure 6.1). 

Figure 6.1—Enter Reconciliation
Entering a Reconciliation 
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2. Enter the function number representing the task you would like to complete 
(Table 6.1). (In this case, enter 1 to mark a range of checks for reconciliation.) 
You can press F1 to select from a list of options. 

3. Press ENTER. The task-related fields display (Figure 6.2). 

Figure 6.2—Enter Reconciliation—Function 1 (Marking a Range of Checks)

Table 6.1—Enter Reconciliation Field Definitions

Valid Entry Definition

1—Mark a range of checks The selecting of the range of continuous check numbers for which 
reconciliation is to be done.

2—Unmark a range of checks The deselecting of the range of continuous check numbers for which 
reconciliation is to be done.

3—Manual mark/unmark entry The tagging or untagging of individual transactions (one at a time) for 
reconciliation.

4—Automatic mark/unmark 
entry

Automatically brings up each item, one at a time, within the range and 
order selected. The operator may elect to reconcile or not as is 
needed.

5—Display a range of checks Allows the viewing of the processing information for the selected 
range of transactions.
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4. Complete the fields according to Table 6.2. Fields that do not apply to all 
functions are noted. 

Table 6.2—Enter Reconciliation Field Definitions

Field Applicable 
Function Valid Entry Definition

Bank All functions 1–10 characters The Use ID for the Financial Institutions 
account for which the manual check was 
written.
• Press F1 for a list of Financial Institutions 

accounts associated with Payroll/
Personnel.

Type All functions *—All Process all checks and Direct Deposits

C—Checks Process checks only

E—Electronic Fund 
Transfers (Direct 
Deposits)

Process Direct Deposits only. This is the total 
of all employee paychecks for which a Direct 
Deposit has been selected. Each transfer is 
for a specific payroll cycle.

Sort Order Functions 1, 
2, 4, and 5

D—Date order/ref # 
order

Sort by date and then reference (check and/or 
Direct Deposit) number within dates chosen.

R—Reference # order Sort strictly by reference (check and/or Direct 
Deposit) number for the range selected.

Ref # range Functions 1, 
2, 4, and 5

0 to 9999999999 The range of continuous check numbers for 
which processing is to be performed. When 
entered in this screen, only the characters to 
the left of the hyphen (ref #) are necessary.

Ref # Function 3 0 to 9999999999 The single check number that you are 
manually marking/unmarking. When entered 
in this screen, only the characters to the left of 
the hyphen (ref #) are necessary.

Pause Functions 1, 
2, and 5

Y—Pause between 
displays

Pause between displays. The Y response 
permits the viewing speed to be controlled by 
the operator.

N—Do NOT pause 
between displays

Deactivates the pause between displays.
Entering a Reconciliation 



Chapter 6—Reconciling Checks
5. At the confirmation message, type Y or press ENTER to accept your entries.

6. When the task is complete and you have viewed the information, a message 
displays asking if you have additional tasks.

7. Type N to exit this task and close the window.

POSTING A RECONCILIATION
Once you post your reconciled checks, you cannot undo the reconciliation. Therefore, 
this task offers two options:

• Preliminary—Returns a preview of the task results. Allows you to review 
transactions prior to posting.

• Final—Completes the task. Run once you have reviewed the preliminary post 
and found no errors. Generates a listing of all transactions which were posted 
and physically updates the records by marking them as “reconciled.”
You can only post checks that have been “marked for reconciliation” (i.e., using 
function 1, 3, or 4 of the Enter Reconciliation task).

Use the following steps to post a reconciliation.

Mark/
Unmarked

Function 4 *—All Selects both marked for reconciliation and 
unmarked transactions. There will be a 
combination of Ys and Ns appearing in the far 
right hand column.

M—Marked for 
reconciliation

A Y appears in the far right hand column. 
Only those items marked for reconciliation will 
appear on the screen. Enter N or 0 to unmark.

U—Unmarked for 
reconciliation

An N appears in the far right hand column. 
Only those items not marked for reconciliation 
will appear on the screen. Enter Y or 1 to 
mark.

Table 6.2—Enter Reconciliation Field Definitions (Continued)

Field Applicable 
Function Valid Entry Definition
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1.  Click Bank Reconciliation > Post Reconciliation on the module navigator (if 
the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Post Reconciliation from the menu bar. 
The Post Reconciliation window displays (Figure 6.3). 

Figure 6.3—Post Reconciliation

2. Complete the required fields according to Table 6.3. 

Table 6.3—Post Reconciliation Field Definitions

Field Valid Entry Definition

Bank 1–10 characters The bank for which the reconciliation is being run.

Prelim/Final P—Preliminary proof 
report only

This option only generates a report; the check status is not 
changed to “reconciled.”

F—Post reconciliation 
entries

This option generates a posted transaction report and 
changes the check status from “marked for reconciliation” 
to “reconciled.” 

Sort order D—Date order/ref # 
order

Sorts the checks on the report in reference number order 
within the date order.

R—Reference # order Sorts the checks on the report in reference number order 
only.
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3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system asks if you would like to file a report.

4. Type Y or press ENTER to produce the report (BRPROOF.L##, where ## 
represents your division number). When the report has been produced, a 
message displays at the bottom of the window.

5. Press ENTER to exit this task and close the window.

Figure 6.4 shows a Preliminary Recon Proof Report that was sorted in Date/Ref # Order 
and produced using detail option (Figure 6.4).

Figure 6.4—Example Preliminary Recon Proof Report

Report Level S—Summary Includes the Date, Type, Ref #, and Amount.
• Note: The bank recap report is printed with ALL reports.

D—Detail Includes the Ref #, Type, Date, Ref Desc, Src, Emp #, 
Employee Name, and Amount.
• Note: The bank recap report is printed with ALL reports.

R—Recap only Generates only the Recap report

Table 6.3—Post Reconciliation Field Definitions (Continued)

Field Valid Entry Definition
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PURGING A RECONCILIATION
The Purge Reconciliation task allows you to remove all reconciled transactions (i.e., 
checks with a status of “reconciled,” including voided checks), unused checks, as well 
as direct deposits from the reconciliation data file. (The information remains in the 
Payroll files.) Most customers only perform this task to reclaim disk space.

We strongly recommend that you backup your division before you purge 
reconciled checks. If you do not have a division backup, you can restore (if 
necessary) from a system backup.

This task offers two options:
• Preliminary—Returns a preview of the task results. Allows you to review the 

checks that will be purged prior to completing the task.
• Final—Completes the task. Run once you have reviewed the preliminary post 

and found no errors. Generates a listing of all transactions which were posted 
and physically updates the records by marking them as “reconciled.”
You can only purge checks that have been reconciled, voided, or marked as 
unused, or direct deposits that have been reconciled.

Use the following steps to purge reconciled, voided, or unused checks, or reconciled 
direct deposits.

1.  Click Bank Reconciliation > Purge Reconciliation on the module navigator 
(if the module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Purge Reconciliation from the menu bar. 
The Purge Reconciliation window displays (Figure 6.5). 

Figure 6.5—Purge Reconciliation
Purging a Reconciliation 
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2. Complete the required fields according to Table 6.4. 

3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system asks if you would like to file a report.

4. Type Y or press ENTER to produce the report (BRPURGE.L##, where ## 
represents your division number). When the report has been produced, a 
message displays at the bottom of the window.

5. Press ENTER to exit this task and close the window.

PRODUCING RECONCILIATION CHECK REPORTS
Payroll allows you to produce a report of the checks entered into your Bank 
Reconciliation system (BRCHKRP.L##). Use the following steps to run a check report.

Table 6.4—Purge Reconciliation Field Definitions

Field Valid Entry Definition

Bank 1–10 characters The Use ID for the Financial Institutions account for which 
the manual check was written.
• Press F1 for a list of Financial Institutions accounts 

associated with Payroll/Personnel.

Date range mm/dd/yy to mm/dd/yy Must be a valid date or all zeros in the first date field. Items 
on or between the dates selected will be deleted. If entered 
as 00/00/0000 to 99/99/9999, the default becomes **ALL**. 
ALL items purges ALL reconciled, unused, and voided 
checks currently present in the reconciliation data files 
regardless of dates.

Prelim/Final P—Reconciliation 
Preliminary Purge 
Report

Only report processing takes place. The report will show all 
entries currently selected for purge.
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1.  Click Bank Reconciliation > Check Reports on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Check Reports from the menu bar. The 
Check Reports window displays (Figure 6.6).

Figure 6.6—Check Reports

2. Enter the required information according to Table 6.5 to define the contents of 
the report. 

Table 6.5—Check Reports Field Definitions

Field Valid Entry Definition

Bank range 1–10 characters The Use ID for the Financial Institutions account for which 
the checks were written.
• Press F1 for a list of Financial Institutions accounts 

associated with Payroll/Personnel.

Date range mm/dd/yyyy The range of dates for which the report is being produced.
Producing Reconciliation Check Reports 
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Status Use the following fields to define the checks that will be displayed, based on status.

• Outstanding I—Include
E—Exclude

Indicate if the results should include or exclude 
outstanding checks (items that have not yet cleared the 
bank statement). If you are including outstanding checks, 
you are asked to enter a second filter:
• * (Marked and Unmarked)—Include all checks that are 

marked and unmarked for reconciliation.
• M (Marked only)—Include only those checks that are 

marked for reconciliation.
• U (Unmarked only)—Include only those checks that are 

not marked for reconciliation.

• Reconciled I—Include
E—Exclude

Indicate if the results should include or exclude reconciled 
checks (items that have already been marked/posted for 
reconciliation).

• Unused I—Include
E—Exclude

Indicate if the results should include or exclude unused 
checks.

• Void I—Include
E—Exclude

Indicate if the results should include or exclude voided 
checks.

Type  *—All Pull both checks and Direct Deposits

C—Checks Pull only checks

E—Direct Deposit Pull only Direct Deposits

Sort by C—Check # order Sort by check number only

D—Date order Sort by date only

P—Payee order Sort by Payee name

Report accounts Y—Report account 
information

Display on the report the account number information

N—Do not report 
account information

Do not include the account information on the report

Table 6.5—Check Reports Field Definitions (Continued)

Field Valid Entry Definition
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3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The system asks if you would like to file a report.

4. Type Y or press ENTER to produce the report (BRPROOF.L##). When the report 
has been produced, a message displays at the bottom of the window and the 
system asks if you would like to produce another report.

Type Y or press ENTER, the system returns you to the Bank field. Enter 
the required information for your report. The new report is appended to 
the existing report (BRPROOF.L##).

5. Type N or press ENTER to exit the task and close the window. 

DISPLAYING YOUR CHECKS
The last step in the bank reconciliation process is to view the list of checks for a specific 
bank or review checks written to an employee. The system displays information on the 
selected check (or checks) on the screen or over several screens (i.e., this is not a 
printable report). This information includes the reference number, check date, amount, 
and reconciliation status.

Checks will always be displayed in reference # order in this task. To see checks 
in different sort orders, use either the Enter Reconciliation or Run Check 
Reports tasks.

Use the following steps to display checks.

Page Break N—No page break No page break will occur except on page overflow

S—Page break on 
status

A new page will begin whenever the status changes

T—Page break on 
type

A new page will begin whenever the type changes

Report level S—Summary Only the check number, status, and amount will be on the 
report

D—Detail The detail items shown on the report are the check 
number, date, payee, amount, type, and status

Table 6.5—Check Reports Field Definitions (Continued)

Field Valid Entry Definition
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1.  Click Bank Reconciliation > Display Checks on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Bank Reconciliation > Display Checks from the menu bar. The 
task window displays (Figure 6.7).

Figure 6.7—Display Checks

2. Enter the required information according to Table 6.6. 

Table 6.6—Display Checks Field Definitions

Field Valid Entry Definition

Bank 1–10 characters The Use ID for the Financial Institutions account for which the 
manual check was written.
• Press F1 for a list of Financial Institutions accounts 

associated with Payroll/Personnel.
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3. When complete, type 0 and press ENTER at the menu option prompt to accept 
your entries. The checks and direct deposits meeting the display criteria are 
displayed (Figure 6.8). 

Figure 6.8—Display Checks—Results

Status Use the following fields to define the checks that will be displayed, based on status.

• Outstanding I—Include
E—Exclude

Indicate if the results should include or exclude outstanding 
checks (items that have not yet cleared the bank statement). If 
you are including outstanding checks, you are asked to enter a 
second filter:
• * (Marked and Unmarked)—Include all checks that are 

marked and unmarked for reconciliation.
• M (Marked only)—Include only those checks that are 

marked for reconciliation.
• U (Unmarked only)—Include only those checks that are not 

marked for reconciliation.

• Reconciled I—Include
E—Exclude

Indicate if the results should include or exclude reconciled 
checks (items that have already been marked/posted for 
reconciliation).

• Unused I—Include
E—Exclude

Indicate if the results should include or exclude unused 
checks.

• Void I—Include
E—Exclude

Indicate if the results should include or exclude voided checks.

Table 6.6—Display Checks Field Definitions (Continued)

Field Valid Entry Definition
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4. Press ESC to end the display, type N to stop any pause in the display, or press 
ENTER to view any remaining checks. When the display is complete, you return 
to the Bank field.

5. Press ESC to display the option menu. The system asks for confirmation.

6. Type Y or press ENTER. The option menu displays.

7. Type E and press ENTER to exit the task and close the window.
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C H A P T E R  7

PRODUCING PAYROLL REPORTS

Payroll allows you to produce a variety of reports to suit the needs of your organization. 
Included with this module are a number of standard reports, or reports that have preset 
column headings. You have the ability to select the accounts and to decide what 
information to include in the report rows.
You can also modify any of the standard reports to meet your needs, or create a new 
report definition.

REPORT CATEGORIES
The Payroll/Personnel reports are divided into three categories:

• Master Record Lists—Reports of the current master records. These reports 
should be printed and saved in an offsite or fire-proof location. In the event of 
computer problems, you can use the hard copy of the report to recreate your 
master records.

• Predefined Reports—Summary or detail reports for selected parameters (e.g., 
date, Financial Institution, account number/mask).

• User-Defined Reports—You can use these reports as a model, customizing them 
to fit your payroll reporting needs.You may also create a totally new report; 
instructions are at the end of this chapter. 

PRODUCING PAYROLL/PERSONNEL REPORTS
Each Payroll/Personnel report lets you select and filter specific information. Because 
each report displays unique information, you will see different options for each.

1.  Click the report name on the HomePage. The parameter window displays. 
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You can also access the report through Report Manager: select File > 
Report Manager from the menu bar; and select Payroll/Personnel, the 
report category, and the report name; and double-click or click 
Produce.

The Produce Reports parameters window displays (Figure 7.1). The parameters 
will vary based on the report that you select. 

Figure 7.1—Produce Reports: Setup List

2. Complete the required report settings. Table 7.1 describes what options you may 
be displayed on the parameters window. The options are presented in 
alphabetical order. 

Table 7.1—Report Parameter Options

Option Entry Description

Account Mask Text box Enter the account or account mask to determine what accounts 
are included in the report. For more information on masks, see 
Using Masks on page 2.14. 

Accounting 
Information

Check box If you are printing detailed report information, you can include 
(check mark) or exclude (no check mark) the accounting 
information. (Applies to the Check History report only.)

Banks Radio buttons Select the applicable radio button to include all or a range of 
banks. 
• All—Includes entries assigned to all banks and entries not 

assigned to any bank (e.g., roll forward, history).
• Range—Includes only those entries assigned to banks within 

the selected range.
If you select Range, you must select the first (From) and last 
(To) banks of the range from the drop-down lists.
Producing Payroll/Personnel Reports 



Chapter 7—Producing Payroll Reports
Check Status Select from 
drop-down list

Select the applicable check status to determine the checks to 
include in the report:
• All checks—Includes checks assigned to all banks and entries 

not assigned to any bank (e.g., roll forward, history).
• Normal checks
• Void checks
• Manual checks

Checks Select a radio 
button

Select the applicable radio button to include all or a range of 
checks. 
• All
• Range
If you select Range, you must enter the first (From) and last (To) 
checks of the range.

Collate Options Select a radio 
button

Indicate if the report should print checks in check number or 
system number order.

Data Items Select a radio 
button

Select the applicable radio button to include all or a range of 
data items. 
• All
• Range
If you select Range, you must select the first (From) and last 
(To) data items of the range from the drop-down lists.

Dates Select a radio 
button

Select the applicable radio button to include all or a range of 
dates. 
• All
• Range
If you select Range, you must enter the first (From) and last (To) 
dates of the range.

Employee 
Selector

Click Button Select employees to be included or excluded from the report.
User-defined reports will include all employees unless you filter 
employees using this selector.
Often you will use the Employee Selector to exclude terminated 
employees from your reports.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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Formatted Text 
(Space 
Delimited (*.txt)

Check box If you select this option, the program will produce a .txt file 
instead of a Print Manager report (i.e., with an extension of L##, 
where ## represents the division number).
• This option inserts quotes (“) as the separator character and 

drops column titles.
• Generally, you will not need to use this option as the filed 

report in Print Manager is a text file that can be pulled into a 
variety of other software (e.g., Notepad or Excel).

Group or Report 
Name

Select a radio 
button

You can produce a single report or a group of reports. (This 
option is also used with report definitions, i.e., you can produce 
the definition of a single report or a group of reports.)
• Report
• Group
The default selection is Report.

• Report/Group 
text box

Text box The enabled text box reflects the radio button selection. Enter 
the applicable report name or group name in the enabled text 
box.
• Report Name—For user-defined reports, the default report 

name reflects the report that you selected in the list of reports. 
(No default displays when you select the User-Defined Report 
Definitions List.)

• Group Name—The program will produce all reports in the 
group. The same reporting date will be applied to all reports. 
By default, the Group name reflects the group of the report 
that you selected in the list of user-defined reports. Change 
this if necessary.

History From Radio buttons Select the source for the history information:
• Checks
• Timesheets

Page Break on 
Change

Check box Select the check box for the report to insert a page break at 
each change in the information (e.g., the report starts each new 
data item on a new page).
If you are going to select data items by which the report will be 
sorted (the Sort Items option), checking this will cause the 
report to page break at each change of the first Sort Item.
If the report has Print Break Totals enabled on the General tab 
of the report definition, a subtotal will also print at each page 
break.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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Period Drop-down list Select the applicable period from which the report information 
will be drawn (e.g., Monthly total, Quarterly total, Beginning 
balance).

Report Select the 
applicable radio 
button.

Select the radio button for your desired report output:
• View—Saves a file (using the report name and the letter L 

plus the division name) in the report directory and displays the 
report in Print Manager.

• Print—Saves a file (using the report name and the letter L 
plus the division name) in the report directory and prints the 
report from your default printer.

• File—Saves a file (using the report name and the letter L plus 
the division name) in the report directory.

Report All Select one or 
more check 
boxes

Select one or more check boxes representing the historical data 
item type (or types) to include in the report.
• Earnings
• Taxes
• Deductions
• Other

Report From Select a radio 
button

Select the radio button representing the source of the report 
information:
• System (i.e., your division)
• ToolBox

Report Level Select a radio 
button

Select the radio button for the type of information to be included 
in the report.
• Summary
• Detailed

Report Type Drop-down list Select the type of report from the drop-down list. For example:
• Account/date/data item/employee detail
• Account/date summary
• Account/data item/employee summary

Reporting Date Text box 
formatted for 
date

Any date-dependent information in your report is in reference to 
this date. Enter the appropriate date. 
• Defaults to the current business date.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
Blackbaud, Inc. 2.143



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.144
3. Click OK. Click Cancel to exit the Produce Reports window without creating 
the report.

See Appendix B—Sample Reports on page 2.225 for example parameter windows and 
reports.

CREATING A USER-DEFINED REPORTS
Payroll/Personnel provides you with a number of standard reports. The module also 
includes a number of “user-defined” reports, for which you can define the information, 
or columns, contained in them.
User-defined reports are employee-oriented and cannot include accounting information 
(you can use Account Distribution reports for that). You may use user-defined reports to 
gather information within a calendar year and compare prior year information for as 
many years as you keep on your computer. 
When you edit or copy a user-defined reports, you define the information that is printed 
in each of 26 columns, A–Z. Columns can include employee data item values or 
lookups, historical data item information for a specific period of time, calculated 
information that adds two or a range of columns, and subtracts, multiples or divides two 
columns, as well as blank worksheet columns that you may use to manually enter 
information.

Secondary Sort Radio buttons Select the second criterion for sorting the report information:
• Employee name
• Employee number

Select Items Check boxes Select one or more data items that the system will use to 
compile the report.

Sort Items Click Button If you do not indicate a sort order of the data items included in 
your report, the report will present employees in employee 
number order.
You should use a sort if you want Page Break and Print Break 
Totals.

Spreadsheet Check box Saves the file as a .TXT file, using quotes as separator 
characters.

Table 7.1—Report Parameter Options (Continued)

Option Entry Description
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Use the following steps to define a new report. 
1.  Select File > Report Manager from the menu bar. The Report Manager 

window displays.

2. Select Payroll/Personnel and the User-Defined Reports category.

3. Click New to set up your customized report. The Report Manager - Edit 
window displays, open to the General tab (Figure 7.2). 

Figure 7.2—Report Manager—Edit

4. Enter a unique 5-character report abbreviation (alphanumeric) in the Name text 
box. This report abbreviation will be used to create the file name in your report 
directory when you produce the report.

5. Enter the 40-character title of the report (alphanumeric) in the Title text box. 
This title will print on your report. 
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The system maintains the Source and Maintain entries. Also, the only option in 
the Report Type drop-down list is the default—User-defined reports. Therefore, 
you do not need to enter anything into these fields.

6. Enter a new Report Group or select an existing Report Group from the drop-
down list. The Report Group is not required; however, this option allows you to 
organize your new reports and print groups of reports with one step.

As you create your own Report Groups, those groups will display in the 
drop-down list. If you have not entered any Report Groups yet, the 
drop-down list will be empty.

7. Enter the total number of lines that can be printed on the page, including 
headings in the Lines per page text box. 

Most reports are printed with 6 lines per inch, so an 11-inch page has 66 
lines. To leave top and bottom margins of 1/2-inch each, enter 60 as the 
number of lines per page. Valid numbers go from 10 to 999.

8. Select the radio button for your Report Spacing: single- or double-spaced. (The 
default selection is single-spaced.)

9. Select one or more of the following Printing Options check boxes:

• Print Page Totals—Includes totals at the end of each page. 
• Print Break Totals—Includes totals each time the first sort item changes. 
• Print Report Totals—Includes totals at the end of the report.

You must select at least one of these options if you intend to include any 
totals in your report.

10. Click Apply to save your report settings (and remain in the report definition 
window).

You can save your report definition at anytime by clicking Apply. If you 
click OK, you will save the report definition and return to Report 
Manager (i.e., close the report definition window).
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11. Select the Columns tab to define the body of the report (Figure 7.3). 

Figure 7.3—Columns Tab

12. Click a Column Types button to add the associated column to the report. The 
column appears in the bar above and a pointer indicates the column position 
(Figure 7.4). 

Figure 7.4—Adding a Column Type to the Report

You can “click and drag” to reorder columns (i.e., click the column, 
hold the mouse button down, and move the column to the new 
position). You can also delete a selected (i.e., highlighted) column by 
clicking Delete.

Define the 
data 
parameters 
in this area.

by 
clicking 
a button 
here.

Add a 
column 
here
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Your report can have up to 26 columns.

13. Define the data you want included in the area on the right according to Table 
7.2, Table 7.3, and Table 7.3. Because access to the fields depends on the 
column type, the tables have been divided by column type. 

Table 7.2—Field Definitions for User-Defined Columns—Calculated Amount

Field Definition

Column Type The default entry is the type of column that you selected by clicking the button. 
However, you can change the column type if necessary by selecting from the drop-
down list.

Operation Select the first column of the calculation (first of two columns or first in a range of 
columns) from the drop-down list.
The existing columns defined “before” the current column (i.e., that display to the 
left of the current column) display. You can only define a calculation based on 
columns displayed before the calculation column.
• For example, if the current column is E, you could write a calculation based on 

columns A, B, C, or D, but not F, G, H, etc.

Select a mathematical operation from the drop-down list. Your options are:

• Plus • Times • Percentage of • Variance of

• Minus • Divided by • Sum thru

Select the second column of the calculation (second of two columns or last in a 
range of columns) from the drop-down list.
The existing columns defined “before” the current column (i.e., that display to the 
left of the current column) display. You can only define a calculation based on 
columns displayed before the calculation column.
• For example, if the current column is E, you could write a calculation based on 

columns A, B, C, or D, but not F, G, H, etc.

Print Column Select this check box if you want the column to print in the report. 
• You can “hide” a column in the report output. This option is very useful if you have 

information you want to use in a calculation (therefore, it must be in the report 
definition), but you don’t want the information to display in the report itself.

Width Enter the width of the column. Default width is 20 characters.
• Remember, the column width must be in relation to the report width, which has a 

maximum of 250 characters.
• This column is enabled only if you select the Print Column check box (i.e., you do 

not need to specify a column width if you are not printing the column in the report).
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Text Line 1 Enter the first line of the column title. The text defaults to the column type.

Text Line 2 If necessary, enter the second line of the column title. 

Table 7.3—Field Definitions for User-Defined Columns—Data Items

Field Definition

Column Type The default entry is the type of column that you selected by clicking the button. 
However, you can change the column type if necessary by selecting from the drop-
down list.

Data Item Select the historical or employee data item that you wish to display in this column 
from the drop-down list.
• When you select a data item, the Value From text box is enabled.

Value From Select the source of the data to be displayed in the report column. This date is 
relative to the report date entered when you produce the report, not the business 
date or the date you create the report definition.
The options will vary depending on the type of data item. For example, 

• Value of the data item • Value of lookup columns

• Monthly total • Beginning balance

If you select an employee data item, the value is based on the existence (or lack) of 
an edit value:
• If the data item does not have any edit values—The value is determined by what 

is entered for the EDI on the employee record.
• If the data item does have any edit values—The value is determined by the edit 

value name for the EDI entered on the employee record. The lookup is 
determined by the corresponding lookup column for the edit value entered on the 
employee record.

Extract Only enabled if the you have selected an HDI. Select the information to extract from 
the drop-down list (e.g., hours, amount).

Table 7.2—Field Definitions for User-Defined Columns—Calculated Amount (Continued)

Field Definition
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Year Only enabled if the you have selected an HDI. Enter the relative beginning year in 
the first text box. 
• The current year is 0. Last year would be –1, next year would be 1.

Only enabled if the you have selected an HDI. Enter the relative ending year in the 
second text box. 
• The current year is 0. Last year would be –1, next year would be 1.

Sum Column Use this option to sum the values in an EDI column. 

Count Column Use this option to count the number of occurrences of a value in an EDI column.

Print Column Select this check box if you want the column to print in the report. 
• You can “hide” a column in the report output. This option is very useful if you have 

information you want to use in a calculation (therefore, it must be in the report 
definition), but you don’t want the information to display in the report itself.

Width Enter the width of the column. Default width is 20 characters.
• Remember, the column width must be in relation to the report width, which has a 

maximum of 250 characters.
• This column is enabled only if you select the Print Column check box (i.e., you do 

not need to specify a column width if you are not printing the column in the report).

Text Line 1 Enter the first line of the column title. The text defaults to the column type.

Text Line 2 If necessary, enter the second line of the column title. 

Table 7.4—Field Definitions for User-Defined Columns—Worksheet Column

Field Definition

Column Type The default entry is the type of column that you selected by clicking the button. 
However, you can change the column type if necessary by selecting from the drop-
down list.

Separator You can leave this field blank or you can enter a character to help define the 
boundaries of the column.
• The pipe sign (|) is commonly used as a separator character.

Table 7.3—Field Definitions for User-Defined Columns—Data Items (Continued)

Field Definition
Creating a User-Defined Reports 



Chapter 7—Producing Payroll Reports
14. When you have completed your report definition, click OK to save the 
definition and return to Report Manager. The report is added to the list of User-
Defined Reports. 

TIPS—REPORTS THAT CROSS FISCAL YEARS

• It is helpful to sketch a user-defined report that crosses fiscal years before 
creating the definition in Report Manager.

• A user-defined report setup to cross a fiscal year makes full use of the Year and 
Period options for HDI columns. 

• A user-defined report that crosses fiscal years must be designed:
— With one column for the months of the fiscal year that fall in the current 

calendar year, and
— One (or more) columns for the months of the fiscal year that fall in the prior 

calendar year
• Each time the report is produced, the Report Date must be the last period of the 

fiscal year, to preserve the relativity of the Year and Period for the prior calendar 
year columns.

Print Column Select this check box if you want the column to print in the report. 
• You can “hide” a column in the report output. This option is very useful if you have 

information you want to use in a calculation (therefore, it must be in the report 
definition), but you don’t want the information to display in the report itself.

Width Enter the width of the column. Default width is 20 characters.
• Remember, the column width must be in relation to the report width, which has a 

maximum of 250 characters.
• This column is enabled only if you select the Print Column check box (i.e., you do 

not need to specify a column width if you are not printing the column in the report).

Text Line 1 Enter the first line of the column title. The text defaults to the column type.

Text Line 2 If necessary, enter the second line of the column title. 

Table 7.4—Field Definitions for User-Defined Columns—Worksheet Column (Continued)

Field Definition
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• Figure 7.5 shows how you can sketch out the relative periods for your report. 

Figure 7.5—Example Relative Period Offset

EDITING A USER-DEFINED REPORT

Use the following instructions to edit any user-defined report to meet the needs of your 
organization. 

1.  Select the user-defined report that you wish to edit.

2. Click Edit. The Report Definition window displays the settings of the report.

3. Modify the report definition as necessary. Refer to Creating a User-Defined 
Reports on page 2.144 for further explanation of the report definition fields.

4. At any time, click Apply to save the report and remain in the report definition 
window. When you have completed the report definition, click OK to save the 
report and return to Report Manager. 

PRODUCING THE DISTRIBUTION AFTER NET CALCULATIONS REPORT
The Distribution After Net Calculations report allows you to create a sorted distribution 
report in account dimension(s) order after net calculations and before check production. 
This report contains account distribution information sorted by a dimension or group of 
dimensions from the account structure for employees of a check run in process.
Before you can create the Distribution After Net Calculations report, you must adjust 
the Payroll Account Distribution Report Parameter.

ADJUSTING THE PAYROLL PARAMETER

Use the following steps to adjust the payroll parameter.

Jan Apr May June July Aug Sept Oct Nov DecMarFeb

–9 –6 –5 –4 –3 –2 –1 +1 +2–7–8

This figure shows the relative offsets for a reporting date in October. You would combine these period 
numbers with relative years to determine your reporting period. For example:

December of the previous year would be relative year –1, relative month +2.
March of the next year would be relative year +1, relative month –7.
June of the current year would be relative year 0, relative month –4.
Producing the Distribution After Net Calculations Report 
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1.  Click Setup > Acct Distribution Rpt Param on the module navigator (if the 
module is not expanded, click Payroll/Personnel first) or select Payroll/
Personnel > Setup > Acct Distribution Rpt Param from the menu bar. The 
Account Distribution Report Parameter displays (Figure 7.6). 

Figure 7.6—Example Account Distribution Report Parameter

2. Type C to change the parameter.

3. Use the ENTER or arrow keys to access Level 5.

4. Enter the report information according to Table 7.5. 

Table 7.5—Parameter Field Definitions

Field Definition

ID Type Enter the ID type for which you will create this report.

Break Enter the dimensions for which the report will break (i.e., sort information).

Dsc By default, the report information is pulled from Descriptive accounts. Press F1 to 
see a list of alternate settings.

Report Enter the dimensions for which the report will create a secondary summary (i.e., a 
subtotal). This must be one of the dimensions included in the break section.
• Note: This design varies from other FundWare distribution report formats.

Act By default, the accounts included in the report will be printed in standard format. 
Press F1 to see a list of alternate settings.
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5. When complete, press ENTER to save the parameter changes. Figure 7.7 shows 
an example that will create a new page for each dimension 1–2 
(fund–department) combination, and subtotals for each unique dimension 1 
(fund). 

Figure 7.7—Example Account Distribution Report Parameter

6. Type E to exit this task and close the window.

Dsc By default, the account descriptions included in the report will be printed in 
standard format. Press F1 to see a list of alternate settings.

Sub By default, the account descriptions included in the report will be printed in 
standard format. Press F1 to see a list of alternate settings.

Table 7.5—Parameter Field Definitions (Continued)

Field Definition
Producing the Distribution After Net Calculations Report 
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PRODUCING OTHER REPORTS
There are a number of additional Payroll reports that are produced using Classic 
windows (Table 7.6). 

The following sections provide instructions for producing these reports.

PRODUCING THE DAILY EARNINGS REPORT

Use the following instructions to produce the Daily Earnings Report.

Table 7.6—Classic Reports

Table Title Category

Daily Earnings Predefined Reports

Employee Change Log Predefined Reports

Calculations List Master Records Lists

Check Formats List Master Records Lists

EFT Form Formats List Master Records Lists

Direct Deposit Parameters List Master Records Lists

Distribution Tables List Master Records Lists
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1.  Click Reports > Predefined Reports > Daily Earnings on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Predefined Reports > Daily Earnings 
from the menu bar. The first page of the report parameters task displays (Figure 
7.8). 

Figure 7.8—Daily Earnings Report Parameters—Page 1 of 2

2. Complete the required fields according to Table 7.7. 

Table 7.7—Daily Earnings Report—Page 1 Definitions

Field Options Definition

Date Range valid 
date

Enter a valid range of dates for the report. Only information in this date 
range is included in the report.

Select Items Valid 
data item

Enter up to three earnings historical data items that the system will use to 
compile the report.
• Leave the field blank to include all data items in the report.

Sort Items Valid 
data item

Enter an employee data item (or press F1 to select from a list of data 
items). The system will use the data item to sort the report.
If you do not indicate a sort order of the data items included in your report, 
the report will present employees in employee number order.
You must enter a data item in this field if you want page break totals.

Page break Y
N

Select Y for the report to insert a page break at each change in the change 
of the Sort Item information (e.g., the report starts each new data item on a 
new page).
Producing Other Reports 
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3. Press ENTER or PAGE DOWN to move to the next field (Figure 7.9). 

Figure 7.9—Daily Earnings Report Parameters—Item Selection

4. Enter the order number for the item selection and press ENTER. (This number 
simply helps you organize your entries, it is not used in the report.) The second 
page of the Daily Earnings report parameters window displays (Figure 7.10). 

Figure 7.10—Daily Earnings Report Parameters—Page 2 of 2

5. Enter the first and last values to filter the information in the report, and indicate 
if these records are included or excluded.

6. Continue entering items until complete.
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7. When complete, press ESC to display the option menu.

8. Type E to end the session 

9. Type 0 to accept your entries.

10. Press ENTER to file a report (accepting the Yes option). The report 
(PYDEARN.L##, where ## represents your division number) is created and 
saved to your Reports folder and you are asked if you would like to create 
another report.

11. Type Y to create another Daily Earnings report or N exit the task and close the 
window.

12. Access the report through Print Manager (Figure 7.11). 

Figure 7.11—Example Daily Earnings Report

PRODUCING THE EMPLOYEE CHANGE LOG

Use the following instructions to produce the Employee Change Log. The Payroll 
Parameter must be defined to save employee change information (field 2—Log 
employee maintenance) to produce this report.
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1.  Click Reports > Predefined Reports > Employee Change Log on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Predefined Reports > Employee 
Change Log from the menu bar. The report parameters window displays 
(Figure 7.12). 

Figure 7.12—Employee Change Log Parameters—Page 1 of 1

2. Complete the required fields according to Table 7.8. 

Table 7.8—Employee Change Log—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Date Range valid 
date

Enter a valid range of dates for the report. Only information in this date 
range is included in the report.

Spreadsheet Y
N

If you enter Y, the system saves the file as a .TXT file, using quotes as 
separator characters.
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3. When complete, press ESC to display the option menu.

4. Type E to end the session 

5. Type 0 and press ENTER to accept your entries. The report (PYSESS.L##, where 
## represents your division number) is created and saved to your Reports folder 
and you are asked if you would like to create another report.

6. Type Y to create another Employee Change Log or N to exit the task and close 
the window.

7. Access the report through Print Manager (Figure 7.13). 

Figure 7.13—Example Employee Change Log

Data Items All or a 
valid 
range

Accept the default entry (includes all employee data items) or enter a range 
to include only the specified employee data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.

User Range All or a 
valid 
range

Accept the default entry (includes changes made by all employees) or 
enter a range to include only the changes made by specific employees. 
If you select Range, you must enter the first (From) and last (To) employee 
numbers of the range.

Table 7.8—Employee Change Log—Field Definitions (Continued)

Field Options Definition
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PRODUCING THE CALCULATIONS LIST

Use the following instructions to produce the Calculations List.
1.  Click Reports > Master Report Lists > Calculations List on the module 

navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Master Report Lists > Calculations 
List from the menu bar. The report parameters window displays (Figure 7.14). 

Figure 7.14—Calculations List—Page 1 of 1

2. Enter a range of data items to include in the report, or accept the defaults to 
include all data items.

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYCALC.L##, 
where ## represents your division number) is created and saved to your Reports 
folder and you are asked if you would like to create another report.

5. Type Y to create another Calculations List or N to exit the task and close the 
window.
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6. Access the report through Print Manager (Figure 7.15). 

Figure 7.15—Example Calculations List

PRODUCING THE CHECK FORMATS LIST

Use the following instructions to produce the Check Formats List.
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1.  Click Reports > Master Report Lists > Check Formats List on the module 
navigator (if the module is not expanded, click Payroll/Personnel first) or 
select Payroll/Personnel > Reports > Master Report Lists > Check Formats 
List from the menu bar. The report parameters window displays (Figure 7.16). 

Figure 7.16—Check Formats List—Page 1 of 1

2. Complete the required fields according to Table 7.9. 

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYFORM.L##, 
where ## represents your division number) is created and saved to your Reports 
folder and you are asked if you would like to create another report.

5. Type Y to create another Check Formats List or N to exit the task and close the 
window.

Table 7.9—Check Formats List—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Data Items All or a 
valid 
range

Accept the default entry (includes all data items) or enter a range to include 
only the specified data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.
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6. Access the report through Print Manager (Figure 7.17). 

Figure 7.17—Example Check Formats List

PRODUCING THE EFT FORM FORMATS LIST

Use the following instructions to produce the EFT Form Formats List.
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1.  Click Reports > Master Report Lists > EFT Form Formats List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Reports > Master Report Lists > EFT Form 
Formats List from the menu bar. The report parameters window displays 
(Figure 7.18). 

Figure 7.18—EFT Form Formats List—Page 1 of 1

2. Complete the required fields according to Table 7.10. 

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYEFTFM.L##, 
where ## represents your division number) is created and saved to your Reports 
folder and you are asked if you would like to create another report.

Table 7.10—EFT Form Formats List—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Data Items All or a 
valid 
range

Accept the default entry (includes all data items) or enter a range to include 
only the specified data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.
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5. Type Y to create another EFT Form Formats List or N to exit the task and close 
the window.

6. Access the report through Print Manager (Figure 7.19). 

Figure 7.19—Example EFT Form Formats List

PRODUCING THE DIRECT DEPOSIT PARAMETERS LIST

Use the following instructions to produce the Direct Deposit Parameters List.
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1.  Click Reports > Master Report Lists > Direct Deposit Parameters List on 
the module navigator (if the module is not expanded, click Payroll/Personnel 
first) or select Payroll/Personnel > Reports > Master Report Lists > Direct 
Deposit Parameters List from the menu bar. The report parameters window 
displays (Figure 7.20). 

Figure 7.20—Direct Deposit Parameters List—Page 1 of 1

2. Complete the required fields according to Table 7.11. 

3. When complete, press ENTER. A confirmation message displays.

4. Type 0 and press ENTER to accept your entries. The report (PYEFTS.L##, where 
## represents your division number) is created and saved to your Reports folder 
and you are asked if you would like to create another report.

Table 7.11—Direct Deposit Parameters List—Field Definitions

Field Options Definition

Report Level S
D

Select the type of information to be included in the report.
• Summary
• Detailed

Data Items All or a 
valid 
range

Accept the default entry (includes all data items) or enter a range to include 
only the specified data items. 
If you select Range, you must enter the first (From) and last (To) data items 
of the range.
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5. Type Y to create another Direct Deposit Parameters List or N to exit the task and 
close the window.

6. Access the report through Print Manager (Figure 7.21). 

Figure 7.21—Example Direct Deposit Parameters List

PRODUCING THE DISTRIBUTION TABLES LIST

Use the following instructions to produce the Distribution Tables List, which lists the 
details of your distribution tables.
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1.  Click Reports > Master Record Lists > Distribution Tables List on the 
module navigator (if the module is not expanded, click Payroll/Personnel first) 
or select Payroll/Personnel > Reports > Master Record Lists > Distribution 
Tables List from the menu bar. A confirmation message displays (Figure 7.22). 

Figure 7.22—Distribution Tables List—Confirmation Message

2. Press ENTER to produce a report (accepting the Yes option). A second 
confirmation message displays asking if you want to file the report.

3. Press ENTER to file a report (accepting the Yes option). The report 
(PYSTDST.L##, where ## represents your division number) is created and 
saved to your Reports folder and you are asked if you would like to create 
another report.

4. Type Y to create another Distribution Tables List or N to exit the task and close 
the window.
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5. Access the report through Print Manager (Figure 7.23). 

Figure 7.23—Example Distribution Tables List

PRINTING REPORTS
Report Manager lets you send Payroll/Personnel reports directly to your printer. You can 
also print reports from the Preview window or from the FundWare Print Manager.

PRINTING DIRECTLY TO YOUR PRINTER

Use the following steps to print directly to your default printer.
1.  Click the report name on the HomePage. The parameter window displays. 

You can also access the report through Report Manager: select File > 
Report Manager from the menu bar; and select Payroll/Personnel, the 
report category, and the report name; and double-click or click 
Produce.

The report parameters window displays.

2. Set the any filtering options you want for the report. See Producing Payroll/
Personnel Reports on page 2.139.

3. Select the Print check box in the Output To section of the window.

4. Click OK. The report is sent to your Windows default printer.
Printing Reports 
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When Master Record List and Predefined Reports print, they append to 
previously-generated copies stored in Print Manager. Each time you run an 
Employee Master List, for example, it adds to the existing one. If you do not 
want this to occur, delete previous versions of reports from Print Manager 
before running a report.

PREVIEWING REPORTS

Report Manager lets you preview reports on-screen. From the preview window you can 
print reports or export them as files in different formats.

1.  Click the report name on the HomePage. The parameter window displays. 

You can also access the report through Report Manager: select File > 
Report Manager from the menu bar; and select Payroll/Personnel, the 
report category, and the report name; and double-click or click 
Produce.

The report parameters window displays.

2. Set any filtering options you want for the report. See Producing Payroll/
Personnel Reports on page 2.139.

3. Select the Preview check box in the Output To section of the window.

4. Click OK. The report opens in the Print Preview window.

If you do not have a default printer selected for the computer, you will 
receive an error message.
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OPENING PRINT MANAGER

The FundWare Print Manager allows you to view, delete, print, format reports, and 
search for text. To access Print Manager, select File > Print Manager on the menu bar. 
Print Manager launches, displaying the Open dialog box (Figure 7.24). 

Figure 7.24—Opening Print Manager

Refer to the Blackbaud FundWare Print Manager Guide for detail information and 
instruction regarding Printing and the Print Manager Setup Wizard.

EXPORTING REPORT INFORMATION
All FundWare reports, including standard reports, trace reports, even check files, are in 
ASCII format. ASCII is a generic format that most spreadsheet or work processing 
programs can read. You can bring any of your FundWare reports into your favorite work 
processor or spreadsheet and modify them there. 

1.  Produce the report. 

2. Note the name and location of your report (i.e., the file name that you use to 
open the file through Print Manager). 
Exporting Report Information 
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For example, the trial balance is called GLTRBAL.L02 for division 02. 
By default, this report is saved as an ASCII formatted file in your 
FundWare > Data folder. 

3. Using the secondary software program of your choice (e.g., Excel), select File > 
Open to open the FundWare report file.

4. The secondary software may display a “Wizard” to guide you through the 
process of importing and formatting the file. Follow these instructions.
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C H A P T E R  8

PAYROLL 941 REPORT AND FORM

The new Payroll 941 Report will allow an organization to create a quarterly  report for 
submission  and is produced on the approved Federal 941 Form through Forms 
Manager.
Dollar amounts are extracted from the Fundware Payroll history files to the report.  
There is a modification program that will allow the user to edit any fields that are needed 
to complete the form.
On initial Setup and subsequent production of the report the following steps will be 
involved:

• "Define Parameter Record
• "Extract 941 Information
• "Modify Fields as necessary
• "Produce the Form for printing in Forms Manager
• "Print the Form through Forms Manager

REPORT SETUP
To define the 941 report, use the Navigator Bar Item, 941 Processing > Define 941 
Report Parameter.
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Figure 8.1—941 Report Parameter

You can also access the Report Parameter programs via the toolbar.
Report Setup 6
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Figure 8.2—941 Report Toolbar

The first time you enter this program, you must do to an A) Add to set up the Report 
Parameter. The information in this parameter can be modified as needed through the C) 
Change function, once it is defined.
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Figure 8.3—Define Parameter Entry

Figure 8.4—Define Parameter Screen 1
Report Setup 8
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The Report Name Defaults to 941.

Figure 8.5—Define Parameter Screen 2

Table 8.1—Define Parameter Screen 1 Fields

Field Definitions and Placement on 941 Form

1)Payer Info Enter the Federal EIN and Employer name and address as it will 
Appear on the 941 form Page 12) Box 14 

2) Box 14 State Enter the state abbreviation for the state where you made your 
deposits OR enter "MU" if you made your deposits in multiple 
states.
Appears on 941 Line 14
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Table 8.2—Define Parameter Screen 2 Fields

Field Definitios and placement on 941 Form

3) History Data Items The Payroll Historical Data Item Names from which to pull the 
wages and taxes. These data items are used for both the quarterly 
and monthly calculations on the form.
It is the Basis Amount on the Data Item that is being Extracted

Federal Press F1 and select the data item where you store your Federal 
withholding, normally .FWT
This information appears in Box 3 of the 941 for

Fica Press F1 and select the data item where you store the Fica taxes, 
normally .FICA
This information appears on line 5a of the 941 form

Tips Press F1 and select the data item where you store tips, or leave 
the field blank
This information appears on line 5b of the 941 form

Medicare Press F1 and select the data item where you store Medicare 
taxes.
This information appears on line 5c of the 941 form.

EIC Advance Press F1 and select the data item where you store eic or leave 
blank
This information appears in box 9 on the 941 form

4) Checkboxes Answer Y if  any of the numbered boxes need to have a check in 
Them otherwise leave the default of N.

Box 15 monthly  Y will X the box  on line 15 that states “You were a monthly 
schedule depositor for the entire quarter. Fill out your tax liability 
for each month.
Monthly tax liability figures will then print in section 15.

Box 15 semi-wk A Y will X the Box on line 15 that states “You were a semiweekly 
schedule depositor for any part of this quarter”

Box 16 final A Y will X the Box on line 16 “If your business has closed or you 
stopped paying wages.

Box 17 seasonal A Y will X the Box on line 17 “If you are a seasonal employer and 
you do not have to file a return for every quarter of the year”
Report Setup 0
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Figure 8.6—Define Parameter Screen 3

Part 4 designee A Y will X the box on Part 4 as a Yes to “May we speak with your 
third-part designee?”  An N will X the box on Part 4 as a No.

Part 6 self-emp A Y will X the box in Part 6, “Check if you are self-employed”.

Table 8.3—Define Parameter Screen 3 Fields

Field Definition and placement on 941 Form

5) Designee Info

Name Enter the name of a third-party Designee, or leave blank
The name if entered will appear on Part 4 of the 941 form

PIN Enter a 5 digit PIN used when talking with the IRS
The PIN will appear on Part 4 under the Designee’s Name

Table 8.2—Define Parameter Screen 2 Fields

Field Definitios and placement on 941 Form
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Figure 8.7—Define Parameter Screen 4

6) Signature Info The data entered will appear on Part 5 of the 941 Form

Name The entered name will appear in the “Print your name here” box.

Title The Title will appear in the “Print your title here” box.

Logo path If you have an image file with a signature, enter the file path to its 
location, otherwise leave blank and sign the form manually.
The electronic signature will be printed on the form next to “Sign 
your name here”.

Date Enter the date of the form for Part 5

Phone Enter a phone to print in part 5 next to “best daytime phone”
Phone number may be entered as a full number string without 
dashes.

Table 8.3—Define Parameter Screen 3 Fields

Field Definition and placement on 941 Form
Report Setup 2
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Table 8.4—Define Parameter Screen 4 Fields

Field Definitions and placement on 941 Form

7) Preparer info This section applies to Paid Preparers only. It should be left blank 
if it does not apply.
This information will appear on Part 6 of the 941 Form

Firm name Enter Firm name of Paid Preparer or leave blan

Logo path If you have an image file with a signature for the paid preparer, 
enter the file path to its location, otherwise leave blank and sign 
the form manually.
The electronic signature will be printed on the form next to “Paid 
Preparer’s Signature

Address Enter the address of the paid preparer or leave blank.

City Enter the city of the paid preparer or leave blank.

State Enter the State of the paid preparer or leave blank.

Zip Enter the zip code of the paid preparer or leave blank.

Date Enter the date the paid preparer signed or leave blank

Phone Enter the phone of the paid preparer.
Phone number may be entered as a full number string without 
dashes.

EIN Enter the Employer Identification number of the paid preparer or 
leave blank.

PTIN Enter the SSN or PTIN of the paid preparer or leave blank.

8) Misc info

Final date Enter the final date you paid wages if field 16 on the 941 form has 
been used when the business has closed or you stopped paying 
wages.  Otherwise leave blank.
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Figure 8.8—Exiting the Define Parameter Screen

Once the screen has been completely filled out, select 0 to accept.  You may then 
perform a C)hange to make corrections  or E)nd to exit the screen as above.

REPORT DATA EXTRACTION
To extract data, use the Navigator Bar Item, 941 Processing > 941 Data Extraction.
Report Data Extraction 4
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Figure 8.9—941 Data Extraction

You can also access the Data Extraction programs via the toolbar.
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Figure 8.10—Extracting 941 Data

Table 8.5—Extracting 941 Data Fields

Field Definition and Placement on 941 Form

1) Report year The 4 digit report year for which the report is being generated.
This determines which history will be pulled from Fundware 
Payroll.

2) Report quarter The Quarter being reported  (1 – 4)
This determines which history quarter will be pulled from 
Fundware Payroll.

3)Total deposits The dollar amount of the total tax deposits that have been made 
for the quarter.

4) Refund The refund option is used to determine which checkbox, if any, to 
use for the box 13 overpayment amount.
                Spaces = not applicable
                A = Apply to next return 
                S = Send a refund.
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Figure 8.11—Accepting the extraction screen

Accept the screen with (0 to accept), if necessary, C)hange or  E) to end, and the initial 
941 extraction  file will be created.

The extraction files are named ##PY9 and ##PY9.IDX, where ## = Division 
number, and will be in the Fundware\data   directory.

REPORT MODIFICATION
To edit data for the 941 report, use the Navigator Bar Item, 941 Processing > Edit 
Extracted 941 Data.
Blackbaud, Inc. 2.187
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Figure 8.12—Edit Extracted 941 Data

You can also access the Edit Extracted 941 Data programs via the toolbar.
Report Modification 8
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Figure 8.13—Display or Change command to edit data

Figure 8.14—Displaying screen 2 of the extracted 941 data
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By doing a D)isplay the data extracted can be viewed. A C)hange will allow changing 
data in any of the visible fields.
When in the screen this program brings up, any of the fields can be modified to 
overwrite the fields pulled from the initial parameter or  to modify dollars amounts if 
needed.
The dollar amounts pulling can be verified by running employee history by period 
reports within Fundware Report Manager.  These reports, if run for the same months or 
quarters as on the 941 report,  will show both the dollars on individual employees and 
totals at the end of the history report that will correspond to the amounts on the 
produced 941 Report.  The reports can be accessed through Report Manager> Payroll> 
Predefined Reports> Employee History by Period.

PRODUCE 941 FORM
To produce the form for the 941 Report, use the Navigator Bar Item, 941 Processing > 
Produce 941 Report.
Produce 941 Form 0
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Figure 8.15—Produce 941 Report

You can also access the Produce 941 Report programs via the toolbar.
Blackbaud, Inc. 2.191



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.19
Figure 8.16—Producing the form

Answer Y)es to produce the form.
Produce 941 Form 2
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Figure 8.17—Exiting 941 Production

At “Do you want another report? Answer N)o and the screen will return to System 
Utilities.
Producing the form also creates a verification print, with the name of PY941VR.L## 
where ## equals the Division Number.  This can be opened through Print Manager and 
appears in Figure 8.18 and Figure 8.19.
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Figure 8.18—Page 1 of the 941 Verification Report
Produce 941 Form 4
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Figure 8.19—Page 2 of the 941 Verification Report.

PRINTING THE 941 FORM
From within your Fundware Division, or through Division 00 Access the Forms 
Manager through File>Forms Manager.
Blackbaud, Inc. 2.195



Blackbaud FundWare Payroll/Personnel Guide—Volume 2

2.19
Figure 8.20—Accessing Forms Manager

Select File> Open, or the Open Icon and you will see a file names PY941FM.X## where 
## is the division number for which the report was produced.  Highlight the File and 
open it.
Printing the 941 Form 6
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Figure 8.21—Forms Manager File Display

On opening the Form, you will receive a message that reads:

Figure 8.22—Forms Manager Message

Press OK.
The form currently produced in this release is Form 941 for 2008:  Employer’s 
Quarterly Federal Tax Return. (Rev. January 2008).
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You can then use any of the available navigation tools within Forms Manager.  The form 
is only 2 pages, so the options are limited

Figure 8.23—941 Form in Forms Manager

If any changes are needed at this point, use the “Edit Extracted 941 Data” 
to edit any field appearing on those screens. If modifications are needed 
to a name or address field, which do not appear in the edit screens, they 
must be made in the “Define 941 Report Parameter” and the data will 
need to be extracted again. When the 941 form is reproduced, the original 
form will be overwritten, so there will never be more than 2 pages.

RECAP OF PROGRAMS FOR 941 FORM
SETUP PARAMETER
Recap of Programs for 941 Form 8
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EXTRACT 941 DATA

MODIFY 941 DATA

PRODUCE 941 FORM
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MTRS PAYROLL RETIREMENT REPORTS

The new Payroll Retirement Report for the State of Massachusetts will allow an 
organization to create an electronic file for submission to MTRS.
The programs are designed for the Teachers Retirement Report for the State of  
Massachusetts, and meets the Massachusetts MTRS specifications.
On initial Setup and Production of the report the following steps will be involved:

• "Define Parameter Record (this is on initial setup only)
• "Extract employee data
• "Edit Extracted Employee Information
• "Produce Electronic File

REPORT SETUP

To define the Retirement Report, use the Navigator Bar Item, Retirement Processing > 
Define Retirement Paramenter.
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Figure 9.1—Define Retirement Parameter

You can also access the Define Retirement Parameter programs via the toolbar.
 2
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Figure 9.2—Retirement Report Toolbar

The first time you enter this program, you must do an A) Add to set up the Report 
Parameter. The default name of the Parameter will display as MA1S.

• "Any fields that are not filled out will have to be edited as needed in later steps. 
Blackbaud Fundware users that are in Massachusetts will have user-defined 
employee data items on their employee records. 
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Figure 9.3—Parameter Definition Screen 1

Table 9.1—Parameter Definition Screen 1

Field Description

1) Agency Enter the school district four-digit agency code assigned by the 
MTRS. 
If the report is being produced for other purposes, this field may be 
ignored.

2) MTRS eligible Enter the data item used on your system to indicate an employee 
should appear on this report.
Pressing F1 will show a list of data items currently available on 
your system.
 4
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Figure 9.4—Parameter Definition F1 key

Figure 9.5—Parameter Definition Screen 2
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The following definitions have been provided for the Massachussetts report.
SCHOOL ID     The School building location code assigned by the DOE

RATE CODE     Identifies the contribution rate in the record being reported. 
Valid entries on the data item that will be stored and extracted are 05, 07, 08, 09 
or 11.

CONTRACT TERM      The length of the contract, expressed in months, 
covering the member whose deductions are being reported. Valid entries are 09, 
10, 11 and 12. To report payments made to an athletic coach who teaches in 
another district, enter 09 in this field.

PAY DURATION   Pay Duration of the contract for the member being 
reported.  Valid values are 09, 10, 11, 12 and LS to indicate the length of time, 
in months, over which the member's contract is paid.  The "LS" value is entered 
for members on a 12-month contract cycle, but who collect their summer pay as 
a lump-sum in month 10. 

PAY FREQUENCY     The annual frequency that pay is issued; valid entries 
are 01-53.  A member who receives pay every week would have a pay 
frequency of 52.  Teachers who receive pay on a bi-weekly schedule usually 
have a pay frequency of 26.  

STATUS   Full-time/part time status.  The percentage of full-time the member 
being reported is working; field is 3-digit numeric; full-time is entered as "100"; 
part-time entries are usually "050" through "099".  While employees who are 
working less than half-time ("050") are ineligible for MTRS membership, it is 
sometimes necessary to report less than half-time values in this field when a 
member is working in more than one school district.  Note that the value listed 
in the annual salary field should show the full-time equivalent salary for 
members who are working and being paid on a part-time basis.    

SALARY     The base annual contractual salary for the member being reported, 
exclusive of any additional compensation (often referred to as "step and 
scale").  This field must be updated whenever a member's salary 
changes.  Additional compensation such as coaching pay or stipends must not 

Table 9.2—Parameter Definition Screen 2

Field Description

3) Data items-employee Pressing the F1 key will again show a list of the data items 
available in your payroll system for extraction.
 6
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be included in the annual salary figure.  For members who are working less than 
full-time, this should be the full-time equivalent salary.  In the monthly 
deduction report the salary figure must conform to the following equation 
where,   b = base earnings n = number of pays being reported f = pay frequency 
p = full time factor expressed as a whole number S = annual salary  S = [(b/n)f]/
[p (0.01)] 

POSITION The member’s genetic position code derived from an MTRS-
defined table; the valid entries in this field are: SUPT  Superintendent  TEACH   
Teacher  TEACH6  Teach - 6 month wait  COACH  Coach (as primary title)  
ADMIN   Administrator  PRIN   Principal  OTHER  Other LTS Long-term 
substitute NURSE School Nurse

GRANT PCT This field indicates the percentage of the member's eligible 
retirement earnings that are derived from federal grant funds. The field accepts 
values from 1 to 100 and defaults to "0" if no input is provided. A "0" is read by 
the system as "no federal grant component in effect".

CERT NUMBER This is the teacher's certification number issued by the 
Department of Education, or the Board of Allied Health Professionals in the 
case of physical therapists or occupational therapists. Other valid entries in this 
field are: P (certification Pending), C (Charter school - no certification number 
necessary), W (Waiver of certification), P2 (member is working with out-ofstate 
certification).

CERT ISSUER Valid entries are DOE (Department of Education) or AHP 
(Board of Allied Health Professionals).

CERT ISSUE DATE The actual date certification was issued.

DED START DATE The date of the first retirement deduction.
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Figure 9.6—Parameter Definition Screen 3

The following fields are pulling from historical data items which contain 
earnings information for the reporting period.

BASE EARN    Contractual base earnings actually paid to the member during 
the reporting period; the sum reported as base earnings should equal the 
contracted annual salary divided by the annual pay frequency, multiplied by the 
number of pay periods being reported.     

Table 9.3—Parameter Definition Screen 3

4) Data items-history
 8
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COACH EARN     Earnings over and above base earnings paid for athletic 
coaching at such times as they occur.  In order to be eligible to participate in the 
system, coaches must be employed and enrolled as teachers.  It is common for 
districts to employ coaches who teach at other districts.

BONUS EARN     Earnings paid as cost-of-living bonus.  Some employers 
refer to this category of pay as a cost-of-living adjustment.    

LONGEVITY EARN     Earnings paid for longevity.  Sometimes this is 
referred to as longevity bonus.

STIPEND EARN     Additional earnings paid as contractual stipends reported 
when they occur; e.g., Choral Director, Department Head, Lead Teacher, 
etc.  Per diem earnings for guidance counselors whose contract requires them to 
work extra days are reported in this field if the extra pay is determined to be 
eligible for retirement deductions.

PREMIUM EARN    Premiums paid by the employer for individual life 
insurance, disability earnings insurance or annuity (403b) contracts, when they 
occur.  Frequently found in administrator's contracts, these are usually 
deductions from payments that are submitted directly to the insurance provided 
(see section on regular compensation).   

RETR DEDUCTION      The retirement contribution actually deducted for the 
member reported in this record.  This is calculated as a percentage of the sum of 
all eligible earnings reported in the previous earnings fields.  The deduction 
rates are:   5% for members who entered service prior to January 1, 1975   7% 
for members whose eligible employment began between January 1, 1975 and 
December 31, 1983   8% for members with membership dates between January 
1, 1984 and June 30, 1996   9% for members who established membership 
between July 1, 1996 and June 30, 2001  11% for members who entered service 
on or after July 1, 2001  11% for members who entered service on or before 
June 30, 2001 and elected to participate in RetirementPlus    

RETR DED 2PC     The "30-plus" contribution deducted for the member 
reported in this record.  Members subject to this deduction contribute an 
additional 2% of all earnings over $30,000 per year.  This additional deduction 
applies to members with membership dates between January 1st 1979 and June 
30th 2001 who have not elected to participate in RetirementPlus.  When the 
system determines that a member is subject to the additional 2% withholding, it 
carries out a validation where: e = total eligible earnings being reported n = 
number of pays in the period being reported f = pay frequency T = additional 
2% deduction amount  T = {e - [(30000/f) n]}(.02)    
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REPAY      Reserved for reporting pre-tax installment payments in the 
deduction record.  Must be combined with a normal contribution input record.

RETIREMENT DATA EXTRACTION
To extract data to the Retirement Report, use the Navigator Bar Item, Retirement 
Processing > Retirement Data Extraction.

Figure 9.7—Extraction Program

You can also access the Retirement Data Extraction programs via the toolbar.
Retirement Data Extraction 0
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Figure 9.8—Extraction Program Report Month and Year

As this program prompts for the month and year of the report, only those paychecks 
within the selected period will be extracted.  This program creates the ##PY4 file where 
## is your division number.  This file can be located in your data directory and is only 
used to hold the extracted data.  The editing program as follows is what is used if 
corrections are needed.
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Figure 9.9—Extraction Program Change or End

Once you have input the Report month and year, you will have the option C) to change 
or E) to End.  Select E if you are ready to extract

DEFINE AND EDIT EMPLOYEE DATA
To edit the extracted data, use the Navigator Bar Item, Retirement Processing > Edit 
Extracted Retirement Data.
Define and Edit Employee Data 2
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Figure 9.10—Edit Extracted Data 

You can also access  Edit Extracted Retirement Data via the toolbar.

The S) Scroll selection may be used to see all the employees that have been extracted.
C) Change will allow selection of the Employee, the Trans type (currently always “N”) 
and the Trans date, or date of the paycheck.
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Figure 9.11—Display or Edit Extracted Data Screen 1
Define and Edit Employee Data 4
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Figure 9.12—Display or Edit Extracted Data Screen 2

Figure 9.13—Display or Edit Extracted Data Screen 3
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Figure 9.14—Display or Edit Extracted Data Screen 4

This task is optional, but provides a good view of the extracted employee 
records in addition to any needed editing. It can be used to manually A)dd 
records that don’t fit within the normal extraction process.

PRODUCE THE MTRS ELECTRONIC FILE
To edit the extracted data, use the Navigator Bar Item, Retirement Processing > Produce 
Retirement Electronic File.
Produce the MTRS Electronic File 6
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Figure 9.15—Produce the MTRS Electronic File

You can also access Produce Retirement Electronic File via the toolbar.
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Figure 9.16—MTRS File Header Production

Table 9.4—MTRS File Header Production

Field Description

1) Report month Enter the 2 digit Report month.

2) Report year Enter  the 4 digit  Report year.
Produce the MTRS Electronic File 8
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Figure 9.17—MTRS File Production Change and End

Accept the screen with (0 to accept) and then either C)hange to change or  E)nd to 
produce the file and exit the program.

This program is pulling out of the ##py4 file that was previously extracted and/
or edited.  It creates the MTRS file in the Fundware\Data Directory that will be 
sent to the State.   The name will be MA1####, where #### is the tty number of 
the workstation where it was extracted. If being accessed through Print 
Manager, it will only be displayed if “Files of Type” All Files is selected.

It can also easily be viewed through Notepad.

RECAP OF PROGRAMS FOR THE MTRS FILE PRODUCTION
1.  DEFINE PARAMETER

2. EXTRACT MTRS DATA

3. MODIFY MTRS DATA
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4. PRODUCE ELECTRONIC FILE

5. SEND FILE TO MTRA (FILE NAME MA1####)
Recap of Programs for the MTRS File Production 0
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PAYROLL BEST PRACTICES

To help you Payroll system run at its optimum, your organization to follow the best 
practices described in this appendix.

DAILY
• Perform housekeeping procedures:

— Delete any TP*.* files in your data directory when everyone is out of 
FundWare.

• Print any error logs immediately. 
• Contact the FundWare Support department if you get an error message. Stop 

working if the error message includes “notify software support.”
• Backup all the FundWare files! Make sure that these backups are successful and 

that you can restore from them, if necessary.
— You should have a system-wide backup process in place. 
— Do not rely solely on the division backup process available in FundWare.

MONTHLY
• Reorg the PY*.* files for each division. (See the Blackbaud FundWare System 

Administration Guide for more information on the reorg task.)
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PAYROLL PROCESS
When you process payroll, FundWare uses files to store the timesheets and the net pay 
calculations until the checks are logged and the history files are updated. The following 
files (found in the Data folder) are used in the payroll process: 

• ##PYA—Store a pointer to the General Ledger–Project/Grant account number. 
## represents your division number.

• ##PYW—Store the timesheets before they are posted. ## represents your 
division number.

• ##PYX and PYY—Store the detail calculations before the checks are logged.  
## represents your division number.

After you post the timesheets (from the Timesheets folder), Payroll removes all records 
from the PYW and moves the detail into the PYX and PYY files. After you log your 
checks (part of the check writing wizard), Payroll moves the detail from the PYX and 
PYY files into the permanent history files (i.e., the PYK and PYL files). Sometimes the 
files become corrupted which result in errors during payroll processing.

BEFORE POSTING TIMESHEETS

• Make a backup of your system.
• Post timesheets.

BEFORE LOGGING CHECKS

• Make a backup of your system.
— Logging checks is the most vulnerable payroll process for errors to occur. 
— If you made a copy of your data files before logging, and an error does 

occur, you will have an easier recovery. 
• Log checks.

AFTER LOGGING CHECKS

• Delete the ##PYA, ##PYA.IDX, ##PYW, ##PYW.IDX, ##PYX, and 
##PYX.IDX, ##PYY files, and ##PYY.IDX (where ## represents your division 
number).

DO NOT DELETE these files if you have timesheets in process or you 
have checks to log for another bank. 
Payroll Process 
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To verify that the files are empty, you can run the following program at a DOS prompt in 
your data directory: rebuild ##pyw /i. This will return the number of records in the file, 
if it is 0, you can safely delete the files. Since the PYA contains pointers to the account 
numbers, it does not remove the records at the end of the process and will not be empty. 
If you are deleting all three files (PYW, PYX, and PYY), you can safely delete the PYA. 
The files will be recreated when the next payroll is processed. 
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SAMPLE REPORTS

Table B.1 provides a sample of each standard report from FundWare Payroll/Personnel, 
as well as each User-Defined Reports. Your reports will vary from the examples based 
on your selection criteria and page break definitions.

Table B.1—Report Titles and File Names

Title File Name

Master Record Lists

Employee Master List—Reports the details of the employee record, except 
direct deposit information. Produce the Employee Direct Deposit List for 
direct deposit employees.

PYLPYM

Historical Data Items List—Reports all fields of the selected historical data 
item(s). Print and file the details for every HDI; reprint and file whenever you 
change the HDI definition.

PYITEMH

Employee Data Items List—Reports all fields of the selected employee data 
item(s). Print and file the details for every EDI; reprint and file whenever you 
change the EDI definition.

PYITEME

Edit Values List—Reports edit value detail for applicable employee data 
items (i.e., EDIs with edit values). 

CIEDIT

Rates and Tables List—Reports all define rates and tables for the selected 
historical data items.

PYTABLE

Banks List—Reports banks in Use ID order. PYBANK

Employees’ Direct Deposit List—Reports details of direct deposit settings 
for employees.

PYLPYM (shown on 
screen as PYLPYME)

Setup List—Reports comments commands (COMNT) from field 8 of the 
historical data item definition.

PYSETUP

User-Defined Report Definitions List—Lists the definitions of user-defined 
reports.

PYLPYP
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History Reports

Employee History by Period PYEHSTP

One Line Check List PYCK1LN

Check History PYCKHST

Account Distribution PYDIST (if you chose the 
spreadsheet extract 
option, the file name is 
##PYXDST, where ## is 
the division number)

Account Distribution By Account PYDISTA

Distribution After Net Calculations—See Producing the Distribution After 
Net Calculations Report for setup instructions.

PYDISTC

User-Defined Reports

941 Information Report PY941

Employee Address List PYADDRS

Employee Contact List PYCNTCT

Employee Dates PYDATES

Quarterly Earnings Reports PYQEARN

Employee Status Report PYSTAT

Employee Telephone Directory PYTEL

Quarterly Unemployment Report PYUNEMP

Employee Record Update Report PYUPDAT

Table B.1—Report Titles and File Names (Continued)

Title File Name
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MASTER RECORD LISTS

Figure B.1—Employee Master List Parameters

Figure B.2—Employee Master List
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Figure B.3—Historical Data Item Lists Parameters
Master Record Lists 
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Figure B.4—Historical Data Items List

Figure B.5—Employee Data Items List Parameters
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Figure B.6—Employee Data Items List
Master Record Lists 
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Figure B.7—Edit Values List Parameters

Figure B.8—Edit Values List

Figure B.9—Rates and Tables List Parameters
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Figure B.10—Rates and Tables List
Master Record Lists 
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Figure B.11—Banks Lists Parameters

Figure B.12—Banks List

Figure B.13—Employees’ Direct Deposit List Parameters
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Figure B.14—Employees’ Direct Deposit List

Figure B.15—Setup List Parameters
Master Record Lists 
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Figure B.16—Setup List
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Figure B.17—User-Defined Report Definitions List Parameters

Figure B.18—User-Defined Report Definitions List
Master Record Lists 
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PREDEFINED REPORTS

Figure B.19—Employee History By Period Parameters

Figure B.20—Employee History By Period
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Figure B.21—One Line Check List Parameters

Figure B.22—One Line Check List
Predefined Reports 
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Figure B.23—Check History Parameters

Figure B.24—Check History
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Figure B.25—Account Distribution Parameters
Predefined Reports 
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Figure B.26—Account Distribution
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Figure B.27—Account Distribution By Account Parameters
Predefined Reports 
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Figure B.28—Account Distribution By Account
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Figure B.29—Distribution After Net Calculations Parameters
Predefined Reports 
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Figure B.30—Labor Distribution After Net Calculations
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USER-DEFINED REPORTS

Figure B.31—941 Information Report Parameters
User-Defined Reports 
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Figure B.32—941 Information Report
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Figure B.33—Employee Address List Parameters
User-Defined Reports 
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Figure B.34—Employee Address List
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Figure B.35—Employee Contact List Parameters
User-Defined Reports 
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Figure B.36—Employee Contact List
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Figure B.37—Employee Dates Parameters
User-Defined Reports 
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Figure B.38—Employee Dates
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Figure B.39—Quarterly Earnings Report Parameters
User-Defined Reports 
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Figure B.40—Quarterly Earnings Report
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Figure B.41—Employee Status Report Parameters

Figure B.42—Employee Status Report
User-Defined Reports 
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Figure B.43—Employee Telephone Directory Parameters

Figure B.44—Employee Telephone Directory
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Figure B.45—Quarterly Unemployment Report Parameters

Figure B.46—Quarterly Unemployment Report
User-Defined Reports 
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Figure B.47—Employee Record Update Report Parameters

Figure B.48—Employee Record Update Report
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GLOSSARY

A
Account Mask—Allows you to group accounts using only one entry. A mask uses a 
variable (X) in place of an actual number. See also Masking.
Account Number—The number that stores transaction information in a financial 
reporting system.
Account Number Structure—Describes how accounts are categorized to represent 
funds, departments, subdepartments, GLAs, and so on. 
Additional Basis—A field on the employee record that contains taxes, deductions, and 
employee costs for employee earnings. Contents of this field are added to the Basis For 
field on the earning’s Historical Data Item definition for the total basis for the earning. 

B
Bank—See Financial Institution and Financial Institution Account.
Basis Amounts—The dollar amount that an earning, tax, deduction, or employer cost is 
based on. For example, an entry for the employer’s share of FICA for $76.50 has a 
“basis amount” of $1,000 in earnings. 
Basis For—A field in the historical data item record on the earning. Taxes, deductions, 
and other data items that the earning is subject to are listed here. The earning will 
“output” to System Registers 3 and 4 for each of the data items listed here. See Internal 
Registers on page 1.252 for more informatin.
Business Date—The date used to post an entry to a ledger. Also called the posting date.

C
Calculation Trace Reports—Line-by-line presentation of calculations and results. 
Separate from transaction trace reports. See also Trace Reports.
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Check Date—The date of the original check.
Check Number—The 7-digit external form number on the check, which is posted to 
history by the log checks task.
Cost Codes—A method of accounting for earnings that is used when wage expenses 
need to be coded to a specific project or job. You might want to use Cost Codes for:

• Employees who work in multiple departments (Cost Codes) but make the same 
rate of pay regardless of where they work.

• Employees whose rate of pay varies with the job they work and all employees 
who work that job are paid that rate.

• Employees who work in different departments and have different rates of pay.
Cycles—Up to 9 calculation cycles are allowed to determine when deductions occur for 
a payroll run (i.e., checks and direct deposit).

D
Data Item—See Employee Data Items and Historical Data Items.
Department—The dimensions or combination of dimensions that defines who an 
employee’s wage expense belongs to. For example, Admin, Sales, etc.
Departmentalized Earnings—Earnings for one employee that are expensed to multiple 
departments. The earnings can be Salary, Hourly, or Other and must be given a 
percentage, with the percentages for each type adding up to 100%. This is determined by 
entry in the setup parameters.
Dimension—A group of numbers within the account number. 
Direct Deposit—A feature that produces an NACHA file and stubs rather than physical 
checks. The file is given or transferred to a bank. Direct Deposit was called Electronic 
Funds Transfer (EFT) in the Classic Edition Payroll/Personnel.
Distribution Tables—A method of accounting for earnings that is used when wage 
expenses can be consistently distributed to the same accounts using the same 
percentages. Distribution Tables work best for salaried employees whose wage expense 
accounts are the same every period or hourly employees whose wage expense accounts 
are the same regardless of the number of hours worked. Distribution Tables do not work 
well for employees whose wage expense accounts change from pay period to pay 
period. The account mask from the table is added to by the account number determined 
for the earning. If the table contains no Xs, it is used exactly like it is, without additional 
account numbers from the earning item.
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E
Earnings Item—An historical data item defined as, E—Earnings, T—Taxes, 
D—Deductions, or O—Other (employer costs and benefits). These HDIs are what you 
use to define earnings amounts on employee timesheets.
EDI—See Employee Data Item (EDI).
Edit Value—A value attached to an Employee Data Item to restrict values placed on 
employee records. Up to 10 types of Edit Values can be placed on an Employee Data 
Item.
EFT—See Direct Deposit.
Employee Data Item (EDI)—A field that stores information on the employee record. 
There are 2 kinds of Data Items: System-defined and User-defined. System-defined 
Data Items are the fields on the employee record (e.g., name, phone number, date of 
hire, salary amount). User-defined Data Items are for additional fields that you wish to 
attach to the employee record or to use for sorting or selecting information for reports. 
Employee Record—A record containing employee name, address, phone numbers, 
dates and earnings information. There is one Employee Record for each employee. 
Employee Selector—A feature that allows you to restrict (i.e., filter) the range of 
employees or records to include in a task or on a report. Using the Employee Selector 
may be helpful if you cut checks at different times based on an Employee Data Item like 
Department.

F
Financial Institution—Any entity that has custody of, and/or manages, cash or cash-
equivalent accounts (e.g., banks, savings and loans). A financial institution can have 
more than one account.
Financial Institution Account—A unique and specific account within a financial 
institution. An account will have a separate statement from the financial institution 
recording activity for the period. An account must be within a single financial institution 
(e.g., checking account, savings account). Accounts are “mapped” to each module.
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G
GLA—Literally “General Ledger accounts.” In everyday usage, they often represent the 
“natural” account or object code of an account number and define what the employee 
does or the cost category to which they belong. However, when we refer to GLAs in the 
program, we are referring to an additional piece of your Payroll setup (.H GLA, .S GLA, 
or .O GLA) and a setting on the employee record. You can use the department and GLA 
to refine how Payroll builds your account numbers.

H
HDI—See Historical Data Item (HDI).
Historical Data Item (HDI)—Any taxes, deductions, benefits, or earnings types that 
determine or affect an employee’s check. There are 4 types of Historical Data Items: 
earnings, taxes, deductions and other. Each Historical Data Item that affects your payroll 
must be brought in from the ToolBox or created by you manually. Examples are comp. 
hours accrued, vacation hours accrued, total all FICA deferred deductions, etc.

I
Inquiry—Allows you to view information like employee records, checks, employee 
history, tax rates and tables, or direct deposit information. 

L
Log Checks—Enters the pre-printed check number into Payroll/Personnel. When you 
log check numbers, the system matches the check number to the system number in the 
employee check history record. This task also posts to the payroll history files and to 
General Ledger and Accounts Payable, when so defined in the setup parameter.

M
Marked for Reconciliation—Checks that are in the process of being reconciled.
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Masking—A “wild card” code used to represent a group of accounts for reports, 
maintenance, or for account duplication. Use a mask to represent a group of accounts 
using only one entry. A mask uses an X in the place of an actual number in the account 
number.

N
Negative Checks—A paycheck amount may appear as a negative number if low 
earnings cause the deductions to be higher than the wage, a one-time deduction is higher 
than the wage, incorrect data items appear on the employee record, or an incorrect 
calculation formula was entered. You should correct a negative amount before you 
produce and print checks.
Non-Departmentalized Earnings (Other Earnings)—“Other” can be 
departmentalized, and is determined during parameter setup. Hourly, Salary and Other 
are defined on the employee record to allow for only one department and wage account. 
You may have none or as many as three non-departmentalized earnings.

O
One-Time Deductions—Deductions that are not normally part of an employee’s 
paycheck. For example, use One-time Deductions to pay back an advance, or adjust the 
amount of a tax or deduction. 
Outstanding—Checks that have been issued but have not been cleared by the bank.

P
Parameter—Determines system configuration, check format, ledger posting, and 
journals used.
Pay Frequency—Determined by the number of checks issued in a calendar year. Pay 
Frequency is controlled by the .T FREQ edit values. Do not change these edit values 
since they are used in computing taxes.
Preliminary Check Register—A Preliminary Check Register shows the result of the 
net pay calculation and a preview of the actual check register. 
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Pre-Notification—An information record sent to the employee’s bank to verify routing 
transit numbers and account numbers for a Direct Deposit. You should define pre-
notification one payroll cycle prior to the payroll cycle that the Direct Deposit will be 
activated or changed for an employee. 

R
Rates and Tables—Are attached to Historical Data Items and contain rates, 
percentages, or amounts. They are used to calculate Historical Data Items. 
Reconciled Checks—Checks that have been posted as processed by your bank.

S
Shortcut Menu—Menu displayed when you click the right mouse button (i.e., right-
click).
Standard Reports—Reports that come with the software. The original reports should 
not be customized, but you may wish to make a copy of a standard report and edit it.
System Numbers—A number on each check and Direct Deposit that is automatically 
assigned by the Payroll/Personnel software. The number is printed on both the stub and 
the actual check. The System Number consists of two parts: the internal number and the 
form sequence number. For Direct Deposit employees, only the internal number prints 
on the Direct Deposit form. A sample System Number might look like this: 1609-0001

T
Time Cards—See Timesheets.
Timesheet Entries—Each entry of an “earnings item.” Earning items may be a number 
of different things (e.g., flat dollar amount such as salary, or a dollar amount based on 
hours or units such as sick time). Each timesheet entry is added to a single timesheet for 
the employee.
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Timesheets—A computerized record of earnings for an employee. Each employee has 
one timesheet, which can have multiple “timesheet entries” to accommodate the 
different types of earnings (e.g., one timesheet can have entries for salary, bonus, and 
vacation time for a single employee). In earlier versions of Payroll/Personnel, these 
were called Time cards.
ToolBox—A set of predefined earnings, taxes, deductions, and employer costs 
(historical and employee data items) that you can copy into your system during setup or 
to update your system periodically. Use of ToolBox items can greatly reduce the amount 
of time required to setup a new payroll. American Fundware, Inc. updates the ToolBox 
data items at the beginning of each year. (As necessary, we also may update ToolBox 
throughout the year.)
Trace Reports—An “audit trail” of all entries made into the Payroll/Personnel module. 
If you use a FundWare financial reporting system such as General Ledger, each time a 
transaction is posted through a journal, a trace report is automatically created and saved 
to a file. See also Calculation Trace Reports.

U
User-Defined Reports—Reports you define. User-defined reports can contain both 
historical and employee data items in a columnar format. Several reports are already 
defined for you in the Payroll/Personnel module. 

V
Voided Check—Checks that have been declared invalid after being written or 
produced. When a payroll check is voided, all journal entries and account payable 
obligations associated with the check are reversed.
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